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CHAPTER 1 Introduction and Installation
1.1  Program Overview

PolySNAP M is a software package designed to match and analyse
powder diffraction patterns utilising their full profiles. The use of the
full-profile allows for more flexible and accurate identification of
samples, even when data quality is low or preferred orientation effects
are significant.

The software provides an easy to use interface to several powerful
and novel statistical methods to rank patterns in order of their
similarity to any selected sample, allowing unknowns to be quickly
identified. In quantitative mode, given a mixture pattern and potential
pure phase patterns, it can identify which patterns are in the mixture,
and quantify their proportions quickly and easily using a non-Rietveld
based approach.

The matching procedure can be automated for high-throughput
analysis. PolySNAP M allows for datasets of up to 96 patterns to be
analysed in a single run, and provides highly flexible graphical output
to summarise and visualise the results. This highlights any unusual
data, and means that time is not wasted looking at the very many
patterns that behave exactly as expected. It can work with or without
the provision of reference patterns, and includes features such as an
automated report writer and a time/date stamped logfile to assist with
audit trail procedures. 
3



4

1.2  Introduction

Four main stages are involved in a standard program run:

1. Import and processing of data files.

2. Match all data files against all other data files.

3. Perform cluster, quantitative and other analyses if required.

4. Output results to file and graphically to screen.

A flowchart representation of the main PolySNAP M processes is
shown overleaf.

1.3  Program Requirements

PolySNAP M requires a modern, high-specification PC running
Microsoft Windows 2000 SP2 or XP SP1 or later. Additionally, a
monitor with minimum 1024 x 768 resolution at 32 bit colour depth
is needed, and an active connection to the Internet.

1.3.1  Note on run-times

On a 2.4Ghz Intel Xeon with 512 Mb RAM, running Windows 2000
Professional SP4, some approximate average program run-times are
shown below.

Times are assuming there are no delays waiting for data, and are
measured from launching the program to the results display screen
being displayed:

These times are approximate, and may vary depending on the
analysis options selected for a given program run - in particular,
allowing for an offset in the matching calculations will greatly add to
the run time.

1.4  Installation

If there has been a previous version of the software installed, then it
is recommended to install the new version in a different location than
the older one; do not install a new version directly over the top.

No. of Patterns Time
50 10 seconds
96 20 seconds



Program Requirements
Insert the CD containing the software in the CD-ROM drive of your
computer. On the CD (normally drive D:\ on most PCs), open the
folder

PolySNAP M Install

and launch the program Setup.exe by double-clicking it.

Note that to install software on Windows 2000/XP systems, the user
must be logged on to an account with system administrator priviliges. 

It will display a welcome window:

Followed by a dialog box allowing the user to control where the
program is installed:

The default path,

C:\Program Files\PolySNAP M\
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should be suitable for most environments, but a different location
may be chosen if required by clicking on the Change Directory
button (please note that installing or running PolySNAP M from a
remote network drive is not a supported configuration).

The next two screens control if a shortcut to the software is added to
the Start Menu and/or the Desktop. The final screen displays a
summary of the selected options; click Install to start the installation
process.

Installation should then proceed automatically, and once completed,
the installer will quit. Depending on the version of Windows, a
restart may be required at this point; if so the installer will notify that
this is the case.

1.5  Launching PolySNAP M

Assuming a default installation, the program may be accessed in one
of the following two ways:

• Run the shortcut to PolySNAP M which the installer will have
placed on the desktop by double-clicking its icon.

• From the Start Menu, select the Programs sub-menu, followed by
the PolySNAP M folder, and then the PolySNAP M option. (It is
usually installed at the very bottom of the list of programs).

1.6  Registering PolySNAP
The copy of PolySNAP that is now installed needs to be registered
before it can be used. A dialog box will appear asking for a Product
Key. 

You will have been provided with a product code of the form:

SNAPx-xxxx-xxxx-xxxx

Enter this code now (case-sensitive, including dashes), and click OK.

The program will now try to connect to the internet to validate the
registration. It will display a message warning you of this, and a
progress dialog box will appear letting you know that this is
happening.

You will then be asked to fill in some registration details. If you have
purchased a license, you will only be asked for your name and email
address. If you are running in a Trial mode, you will be asked for
some more details. Click OK when complete.



Program Requirements
NB: your email address and other information will not be passed to
any third party and will not be used for any other purpose.

If you have any problems with the process, or are unable to connect
to the internet, please contact us directly at

snap@chem.gla.ac.uk

Once this registration process is complete, the program logo screen
will appear for a few seconds, before being automatically dismissed:

The main PolySNAP M window will then appear, and will by default
fill the entire screen:

You are now ready to begin working with the software.
7



8

Please note that a searchable PDF on-line version of this manual can
be viewed at any time during the program by selecting View Manual
from the Help menu. 

1.7  Installation Troubleshooting
Problem
Program registration was not completed, because PolySNAP was
unable to connect to the internet.

Solution
If the registration process could not connect to the internet to validate
the install, then it will have displayed an error and a corresponding
unique Installation Code for your copy. Please either email this num-
ber, along with your Product Code, to snap@chem.gla.ac.uk or
using another computer visit

www.copyminder.com/activate.php
to obtain an activation code manually.

Problem
A message box displaying an error ‘51’ is displayed during program
installation. The program will not launch correctly and may display
further errors after this occurs.

Solution 
Search the Windows System Folder and its subfolders (usually
C:\WINNT for Windows 2000, or C:\Windows\ for Windows XP), for
copies of the file CCMOVE32.DLL. Move this file to a different loca-
tion (e.g. C:\temp), then re-run the program installer.

Problem
When PolySNAP M is launched, a Microsoft Office Installer window
keeps repeatedly appearing and cannot easily be dismissed.

Solution
This problem occurs on a system where the currently logged in user
has never previously run any of the installed Microsoft Office appli-
cations on this machine. Keep clicking Cancel until the window
finally goes away, and then quit PolySNAP M. Launch any installed
Office application, e.g. Word, and the same installer window will
probably appear. This time allow it to run to completion, and click
OK when requested. Once Word has fully loaded as normal, exit the
program and then run PolySNAP M again. It should now run nor-
mally without any further interruptions from Office.



Program Requirements
Problem
Problems may occur with the graphics panes – for example, strange
artefacts may appear on the graphics panes in the results display
screen (such as some of the lines in the dendrogram not being visi-
ble), the program may freeze when a graphics pane is being inter-
acted with (e.g. rotated, zoomed etc.) or the program may hang when
attempting to first display the results screen at the end of a program
run.

Solution

This problem can occur on systems that have graphics cards that are
not 100% compatible with the standard OpenGL libraries. As a
workaround, first quit PolySNAP M, then go to 

Start Menu -> Settings -> Control Panel -> Display. .

Under the Settings tab, click the Advanced button on the bottom right
of the pane. In the window that appears, select the Troubleshooting
tab, and move the Hardware Acceleration slider down to one notch
above the far left hand side (“None”). Click OK, then OK again.
Restart PolySNAP M and see if the problem has been resolved
9
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CHAPTER 2 Using Automatic Mode
2.1  Starting Automatic Mode

To run in automatic mode, select the Automatic Analysis option from
the File menu (this is only available when no other databases or
match windows are open). 

The options from which to choose are presented:
11
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2.1.0.1  Run on...

This menu item gives the following options:

This allows the location of the required files to be selected on a run-
by-run basis, without having to change the default settings in the
PolySNAP M program options. 

Note that setting the input folder to be the same location as the output
folder is not permitted.

The initial paths listed in this window will correspond to those
defaults found in the options window. The three main sections are as
follows:

• Select folder containing Sample data files

This option allows the user to run PolySNAP M analysis on either a
folder containing multiple individual data files. 

Folder Selection: 
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Clicking on the Folder... button will open the following window: 

This window allows selection of an entire folder, rather than a single
file within a folder. 

From the upper selection area any available local or network drives
can be selected, and doing so updates the lower region to display all
folders contained on that drive.

By double-clicking on a folder name, it may be opened, and any
folders contained within that folder are then shown.

To select a folder to use as the main folder, double-click on it to open
it. For example, in the screenshot above, the folder at
C:\tutorial\simple_txt\ is selected.

Clicking OK results in the selected folder path being displayed in the
settings window.

• Use folder containing Known/Reference data files

When importing files, new samples can be optionally compared to
patterns of known samples. If known samples are available to be
compared, their location may be set here after turning on the
checkbox. In this case, two options are available to the user:

- to select a folder containing one or more individual pattern files,
click on Folder... and select a folder as described above

or 

- to not select any known phase source at all, turn the checkbox back
off, and the location is set to <None>.
13
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Copies of the selected patterns are stored in a file knownphaseDB.par
within the selected output directory. The original data files are left
untouched.

• Select folder to save output files

The program has to be given a set location in which to save all of the
output files created by an automatic run. This can be manually set to
any folder as required by the user (although having the output and
input locations the same is not permitted).

Note that if an output folder is selected that already contains files
from a previous run, those files will be deleted prior to the new run
starting.

Click on Folder...to open the folder selector as above. From here any
output folder can be selected as required; note that a New Folder
button is available to allow the creation of a new, empty folder if
required.

• Advanced Options

The options here allow additional optional processing to be
performed upon the data as it is imported. The options are to subtract
background, de-noise the signal, check for amorphous samples, and
to allow an x-shift between the patterns.

Additionally, when turned on, the checkbox Mask Selected Pattern
Regions... brings up a dialog box allowing up to three independent
regions of the pattern to be masked to zero intensity. 

This allows for impurity peaks or problem background areas etc. to
be removed prior to matching. 

The final option, Only match within the range [] to [], allows a single
subregion of the full angle range to be used for comparison. This can
be useful to concentrate the analysis on a single area of interest
within a larger pattern.

The processing options (Background subtraction, smoothing,
shifting, etc.) available here are discussed in more detail in the
Options and Defaults chapter.
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2.1.0.2  View results... 

This option allows the results from a previous run of PolySNAP M to
be displayed and examined without having to wait for all the analysis
to re-run. Selecting it will open a standard file-selection dialog box:

Locate the folder containing all of the output files from a previous
run. Inside this folder will be a database file, whose filename will be
in a similar format to Run_09-11-2002.par (the numbers refer to the
date on which the run was performed).

Select this database file and click Open. The main PolySNAP M
results window will appear and display the results - see Section 2.3.

Note that certain program options are not available in View Results
mode.
15



16
2.2  Running PolySNAP M

2.2.1  File formats that can be imported

Text files (filename.txt) (filename.prn)

These should be standard ASCII text files. The angle should be the x
data, and the corresponding intensities the y data. The x-y data must
be in the format:

x1 y1
x2 y2
. .
. .

etc. 

The fields must be tab-delimited.

If the first line in the file begins with either a '#' or the string 'ID: ', the
rest of that line is used as the 'Pattern Name' for the pattern. 

Any subsequent lines beginning with the '#' character are ignored.

Comma-separated value files (filename.csv)

These should be standard ASCII CSV files, containing the x-y data in
the format:

x1,y1
x2,y2
.,.
.,.

etc. 

If the first line in the file begins with either a '#' or the string 'ID: ', the
rest of that line is used as the 'Chemical Name' for the pattern. 

Any subsequent lines beginning with the '#' character are ignored.

CIF (Crystallographic Information Format) files             
(filename.cif)

The program contains a CIF-format translator that reads standard
version 2.0 Powder CIF files. Although the only data necessary for
SNAP is the x-y intensity data, the rest of the CIF information - such
as chemical names and formulae, author names and addresses etc. are
also retained in the database for reference purposes, and may be
viewed from the Pattern Editor window. Additionally, unit cell
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dimensions and contents are read in if present for use in Quantitative
Analysis mode.

For more information on CIF format files, see the IUCr website at:

http://www.iucr.org/iucr-top/cif/pd/index.html

Bruker Raw Format files

The program can import data from Bruker RAW format. This is a
binary file-format, so cannot be edited or viewed in a conventional
text editor. There are several different types of RAW format; PolyS-
NAP M should be able to import all versions up to Version 4. 

Although the only data necessary for PolySNAP M is the x-y inten-
sity data, much of the rest of the information stored in the file - such
as chemical names and formulae, author names and addresses etc. are
also retained in the database for reference purposes, and may be
viewed from the Pattern Editor window. 

PolySNAP M Pattern files (filename.pat)

Patterns in PolySNAP M databases can be individually exported in 
the program’s own .pat format. This format contains the original x-y 
raw data, any processed data - e.g. the profile after noise removal, 
marked peak positions and any other data fields present. Once saved 
as separate files, they can then be re-imported to the same or a 
different database at a later date.

2.2.2  Import all data files

Assuming no data files are present when the automatic mode run is
started, a screen similar to the following is displayed:

The location of the directory which the program is monitoring for
input data is displayed. The number of files expected, and the number
loaded so far are also given. It is possible to change these settings at
this stage by clicking on the Preferences button to bring up the
program options dialog described previously.
17
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Clicking Exit Auto Mode returns the program to the usual interactive
mode, and cancels the automatic run. The user will be asked to
confirm that they did mean to select this option.

The Match Now option overrides any settings to wait for more
patterns, and causes the program to proceed directly to the next
phase. Again, the user is asked if they mean to pursue this course of
action, as it may cause some data files to not be imported.

If all file locations were correctly set, a database file is created in the
output folder defined earlier. This contains all the imported patterns.
Any output from PolySNAP M is saved in this same directory,
including the logfile, SNAPlog.txt, which describes the success or
otherwise of importing each datafile, the results of the matching and
clustering process, and other useful information.

Once files are found and imported, extra information is displayed at
this stage in the form of a list of imported files, and a graphical
representation of the most recent pattern to be imported:

The first file imported to the database is displayed by the top graph,
the most recently imported file is represented by the lower graph.
Other patterns imported can be displayed on the upper graph by
selecting the pattern of interest from the list. 

Any files which could not be imported are recorded in both the
SNAPlog.txt, and the errorlog.txt file.

2.2.3  Examine the imported data files

Once all of the expected samples have been imported, the program
examines the patterns. Several steps are performed at this stage (see
also the flowchart in section 1.3 on page 5):
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1. Patterns are checked to see if they may be amorphous. This
involves calculating how much pattern would be left if all of the
background areas were removed, as well as how many peaks of
reasonable intensity there are superimposed on that background.

2. If known phase files were provided, the program compares each of
the imported patterns to each of the known phases. Any good
matches are recorded and will be displayed later.

3. For patterns that did not match any of the known phases
sufficiently, quantitative analysis is performed to establish if they
might possibly represent mixtures of more than one of the known
phases provided. The quantitative analysis techniques described in
the manual analysis section are performed with an additional step
which removes each suggested component in turn, to establish if that
improves or worsens the fit to the original pattern. In this way,
patterns that are incorrectly included can be weeded out.

2.2.4  Match all data files against all other data files

Upon commencement of this phase, a progress dialog is displayed:

The various matching tests selected are then performed, and this may
take some time, so patience is required.

2.2.5  Perform cluster and quantitative analyses

Once the matching has been completed, the results are passed into
the cluster analysis module, which then starts to try to group the data
into similar clusters, and estimate their number. Again, this may take
some time.

When more than 50 patterns are being examined, a progress bar is
displayed to give some information about how far through the
calculation is:
19
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Note that while the clustering is underway, the main screen display is
not updated in any way. Therefore, it may sometimes appear as if the
program has crashed or frozen, as it will not respond to the mouse or
keyboard during this process. Patience is recommended at this point. 

2.2.6  Output results to file

Once the clustering is complete, a copy of the raw numerical results
from the matching is saved to the PolySNAP M output folder within
the current working directory in the file correlations.txt; other output
is saved to the logfile. Various other output files are also created,
which are described in Section 2.5.



Results Display
2.3  Results Display

Once the analysis is complete, the display screen is loaded and
results can then be examined in a variety of ways. 

In general the display consists of a display area at the top, in which
the style of view can be altered by selecting the different tabs running
along the top of the window.

The bottom half of the results display is an area giving information
on the currently selected sample file or files. This comprises relevant
textual information relating to the selected pattern, and a graphical
representation of the pattern profile. By default, the first pattern to be
imported is displayed at first. Note that the pattern information
display is by default common to all display modes. 

Additional controls are available from the menus at the top of the
screen.

2.3.1  Display Options Overview

The various display modes available from the tab bar are as follows:

The first four displays each provide separate and different
assessments of the number and types of groups of patterns presented,
calculated using the various different methods described below. As a
result, the groups suggested in each display mode may not
correspond to the groups suggested by another. It is the responsibility
of the user to determine which of the separate methods is providing
the best results. The more the results from different methods are
21
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internally self-consistent, the more confidence there is in the overall
result.

Cell Display

This screen displays the results of comparing the samples with any
known phases provided, and any resulting quantitative analyses of
mixtures. (If no known phases are present, the Cell Display shows
the Dendrogram-plotted results in a different form - see
Section 2.3.5.1 for more information.).

Dendrogram

This screen displays the results of the cluster analysis of the patterns
provided.

3D (MMDS)

This screen shows the plotted results of performing metric
multidimensional scaling upon the distance matrix.

3D (PCA)

This screen shows the plotted results of performing principal
component analysis upon the modified correlation matrix.

N.B: If either the 3D (MMDS) or 3D (PCA) have two stars next to
their name, e.g:

then this informs the user which method of the two has produced
markedly better results than the other for this particular run. If no
stars are displayed, then the methods are producing relatively similar
results, in terms of their reliability.

Numerical Results

This tab displays the numerical values returned from the Match All
process undertaken that compared each sample with every other
sample.

View Logfile

This tab displays all of the textual output written to the SNAPlog.txt
file during the importing, processing and analysis undertaken by the
program earlier. It is also updated automatically if the user manually
overrides any of the PolySNAP M results.

Each of these options are described in detail later.
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With the exception of the the Logfile pane, all of the displays above
allow the selection of one or more sample data files; this is normally
done by clicking once on the sample of interest, which will then
become highlighted. Information regarding the selected sample will
then be displayed in the Sample Information pane at the bottom left
of the window.

2.3.2  Sample Information Pane

For a selected sample, the sample information pane displays relevant
textual information on the left, and a graphical representation of the
sample profile on the right. Although this information pane is always
available by default, it is possible to hide it if more screen space is
required to examine results in the graphical display areas of the
window.

Selecting Hide/Show Pattern Information from the Display menu
allows the information region to be hidden or shown as required.
23
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The right-most region shows the current powder pattern profile; it
can be zoomed in by using the mouse to drag a rectangle over the
relevant area:

The graph pane is part of a larger area that shows information
regarding the selected sample. To the left of the graph appears an area
with text information associated with that sample:

Typical information displayed includes the data file location, the
angle range, the data points for the original raw data and once any
processing has been performed, the known phase most similar to this
pattern (if present), and finally other relevant information regarding
the sample preparation, if saved in the data file headers.

2.3.2.1  Multiple Selection

If more than one sample pattern has been selected in a given display
screen, the pattern information pane displays a list of the patterns
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selected, and shows their profiles plotted on top of each other for
easy comparison:

To identify which profile corresponds to which sample, hover the
mouse over part of the line, until a tooltip appears containing the
sample filename:

Alternatively, selecting the Show Pattern Key on Graph item in the
Display menu brings up a visual colour-coded key:

Multiple non-contiguous selection is achieved by clicking on
multiple patterns with the Control key held down on the keyboard,
for example:

Individual patterns can be de-selected in a similar manner, and their
profiles will be removed from the graph.
25
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Alternatively, a continuous number of consecutively displayed
patterns may be selected by holding the Shift key down and clicking
on the first and then last pattern in the desired range, for example:

When multiple patterns are plotted, selecting Toggle Mode from the
right-click menu displays all but the most recently selected pattern in
the same colour, to allow easier comparison between one particular
pattern and several others.

2.3.2.2  Additional Pattern Options

More options for examining and editing patterns and their
assignations are available from the main program menubar. When an
individual pattern is selected, the Pattern menu is available. It
contains the following options:
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Edit... 

Selecting this option, or clicking the Edit Pattern button causes the
standard PolySNAP M pattern editor to appear with the current
selected pattern loaded into it:

Refer section 3.3.1 on page 76 for full Pattern Editor description and
functions.

Manual Match/Quantitative...

This submenu has the options for matching the selected sample
pattern to either the rest of the sample database, or the database of
known phases (references), if present.

This opens a standard PolySNAP M Match window, allowing a
manual comparison or analysis to be performed on the selected
pattern. See section 3.4.1 on page 92 for more information on the
Match window.

View/Edit Nearest Known Phase...
27
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This option is only available if a comparison with a known-phase
database was done during the analysis. If so, selecting a particular
pattern and selecting this option brings up the following window:

The selected sample is plotted in green, and the known phase the
program considers to be the best match to it is shown overlaid in
blue. The actual matching statistics are displayed on the top right.

To see how well the sample compares to any of the other known
phases provided, select the name of the phase from the pop-up list,
and click Change:

The pattern overlay, and matching statistics, will update to represent
the newly selected pattern.

To retain a changed assignation of a nearest known phase, click OK,
and answer in the affirmative to the presented dialog box.

To keep the program-calculated nearest phase, click Cancel.

View Frame Image...

If the original GADDS frame file corresponding to the current
pattern is available, and was saved in the same input data directory,
clicking the View Frame button or selecting this menu item will open
the Bruker GADDS software to display the frame image.

Note that this option requires both the GADDS software to be
installed on the local computer, as well as a script file,
DisplayFrame.slm, to be placed in the GADDS scripts directory. This
should have been done by use of the option Set GADDS... in the
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program options Automatic: Advanced tab, but if this menu item fails
to work, check that this file is correctly placed.

View Pattern Using EVA

If the current pattern was imported from a RAW format file, this
option allows it to be opened in the EVA software package for
examination. Note that EVA must be set up as the default editing
software for RAW files, and be installed on the local computer.

Override Crystallinity Indicator...

This brings up a dialog box allowing the user to manually override
the program-calculated crystallinity marker setting:

The user can then choose to mark the currently selected pattern as
either Crystalline, or Non-crystalline. (The criteria for what the
program considers to constitute a non-crystalline phase were defined
earlier in section 4.6 on page 144).

It may be useful to view a list of all samples from a current run that
are marked as non-crystalline; this functionality is available from the
Tools menu option List Non-crystalline Patterns... described in
Section 2.3.15.1.

2.3.3  General Graphical Display Pane Options

The various graphical display panes - the Cell Display, Dendrogram,
Screen and two 3D plots - all share many similarities in their options
and controls, and are hence initially described together here.
29
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2.3.3.1  Display Controls Common to All Modes

To zoom in to a region of a graphical display, with the left mouse
button held down, drag a rectangle over the region you wish to zoom:

The screen will then redraw with the contents of the rectangle filling
the display area:

To move the contents of the display window, for example to move the
contents up to see more results than will fit in the window by default,
hold down the Alt key on the keyboard, and drag the mouse in the
desired direction of movement.

2.3.3.2  Additional General Options of the Graphics Panes

Right clicking on the graphics pane causes the following menu to
appear:



Results Display
Reset View - This feature will return to the original view of the
display if it has been moved or zoom has been activated. 

Zoom In - Will zoom in on the centre area of the current display.

Zoom Out - Will zoom out from the centre of the current display. 

Toggle Mode - This feature switches between viewing the patterns as
Pie Charts or Stacks when in Cell Display mode, or between the full
and simplified views of the Dendrogram in that mode. 

Centre Selection - The currently selected item will be centred in the
display.

Deselect all - Any patterns that have been highlighted in the display
will be de-selected with this option. 

Show Toolbar - The optional toolbar at the top of the graphics pane
can be hidden or shown with this feature. The toolbar provides access
to most of the options available through the right-click menu; for a
full description see Section 2.3.3.3.

Print - The standard Windows print dialog box will appear, allowing
the current graphics display region to be sent to a printer.

Copy - The whole of the current graphics display will be copied to
the clipboard, and then can be pasted into any other standard
Windows program - for example, Microsoft Word.

Copy selection - This option allows smaller specific regions of the
graphic display to be copied. Click on Copy Selection, and then drag
a rectangle over the area to be copied: This area only will now be
copied to the clipboard, and can then be pasted in elsewhere as
required. 

Other mode-specific display options (e.g. Show Grid/Show Labels/
Show MRP Marks are discussed under the relevant display section).

2.3.3.3   The Toolbar

The basic functions of the toolbar are illustrated below:

Zoom out

Change Font

Colour

Move Down
Centre Selection

Toggle Mode Print and 
Copy

Move up
Move Right

Reset View

Zoom in

Move Left

Line size
Zoom out

Change Font

Colour

Move Down
Centre Selection

Toggle Mode Print and 
Copy

Move up
Move Right

Reset View

Zoom in

Move Left

Line size
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Reset View - This feature will return to the original view settings of
the display.

Clicking on the small arrow next to the Reset View button allows
access to the options for both Reset View and Deselect All.

Zoom In - Will zoom in on the centre area of the current display.

Zoom Out - Will zoom out from the centre of the current display. 

Toggle Mode - This feature switches between viewing the results as
Pie Charts or Stacks for Cell Display Mode.

Clicking on the small arrow next to the Toggle Mode button allows
access to the options for use on graphics panes where there are a Grid
or Labels displayed - these two options then allow them to be
switched on or off as desired.

Centre Selection - The currently selected item will be centred in the
display.

Move Left - The current display will move one unit to the left.

Move Right - The current display will move one unit to the right.

Move Up - The current display will move up one unit.

Move Down - the current display will move down one unit.

Print - The standard Windows print dialog box will appear, allowing
the current graphics display region to be sent to a printer. 

Clicking on the small arrow next to the Print button can be further
used to access the Copy and Copy Selection options described above.

Line size - Clicking on the arrow next to the Line Size button opens a
pull-down menu with a series of options for line size numbered 1 to
5, with 1 being the thinnest and 5 being the thickest. A dot appears
next to the thickness currently selected. The line size options changes
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the thickness of lines on the graphical displays which may be useful
when preparing images for publication.

Colour - This option allows the colours of both the foreground and
background to be altered to suit the user’s requirements. Note that
these will be reset on the next launch of PolySNAP M:

Background: The default colour is black, simply click on the
down arrow next to the colour box and select Background:

This will now display the colour palette from which a colour
can be chosen.

The colour selected here will then be applied to the background
of the current view. Note that it may be useful to change the
colour of the background to white before printing. 

Foreground: The foreground selection is performed in the
exact same way as the background, only this time selecting
Foreground from the options presented:

The foreground option will alter the colour of the text or axes
used in the current display.
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Font - Finally clicking on the Font button will open a standard font
options dialog box:

This can be used to select the format of the text that will appear on
axes labels, plot headers and pattern labels.

2.3.3.4  The Display Menu

Further options to control the output screens are available from the 
Display menu:

Show Pattern Information, Show Pseudo Cell Display, Show Pattern 
Key on Graph and Show Dendrogram Colours on 3D plots are 
discussed elsewhere.

Show Amorphous Samples on 3D Plots

This toggle determines if samples that are flagged by the program as
being amorphous are shown or not on the standard 3D plots. It is only
enabled when more than one pattern is labelled as amorphous. In
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some cases, hiding such samples can make the plots appear quite
different - this is often especially the case in the PCA plot. 

In the examples shown here the majority of the patterns are
artificially 'flattened out' by the extreme distance between them and
the amorphous; removing the amorphous allows for a better
representation of the distances between the remaining patterns.

Show Sample Labels if Available

If the sample filenames are of the form where some form of sample
ID is contained within the filename, then that information can be
extracted and displayed to help identify the samples.

For example, with this option turned off, a typical display might
resemble:
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Whereas with the option turned on, the display would look like this:

The default for this toggle is on.

Note that all the files in a given dataset must have the same consistent
format for Well IDs to be displayed. See the Options and Defaults
section for details.

Show Graphics Toolbars

This toggles the toolbar displays which are available on some of the
graphics panes. The setting is persistent for a given run, but may be
overridden temporarily by means of the Show Toolbar option
available in the right-click pop-up menu of most of the different
displays.

Show Normalised Pattern Profiles

This option toggles the graph pane between displaying all profiles on
a common intensity scale, where the maximum value is always 1.0,
to displaying the profiles with their maximum intensities as recorded
in the original data files. The default for this toggle is off.

Show Processed Pattern Profiles

This option toggles the graph pane between displaying all profiles
with any processing - such as background subtraction or smoothing -
or in their unprocessed original form. The default for this toggle is
on.

Offset Overlaid Profiles -> on x-axis, on y-axis

The two options in this submenu may be selected independently of
one another. They control how patterns are displayed when more
than one profile is shown on the graph pane at a time.

By default, overlaid profile traces are plotted directly on top of each
other. By using these display toggles however, they may be plotted
with a slight offset in either the x- or y-axes, or both. This may enable
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differences or similarities between the patterns to be observed more
clearly. 

For example, the screenshots below show first, several directly
overlaid patterns, then the same shifted in the x, and then in the y, and
finally shifted with both options turned on:

Note: it is important to remember to check that the x-shift option is
turned off when trying to see if the peak positions of two patterns
coincide or not!

2.3.4  Cell Display

This display mode is the default display choice.

The Cell Display comprises of a pane in which the patterns loaded
are each represented by an individual pie chart. Each pie chart is
colour coordinated to group together similar patterns.
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The cell display can be shown in either of two modes - as standard
pie charts (the default), or as 'stacks':

To switch between the two view modes, right-click on the display,
and select Toggle Mode from the resulting menu.

Depending on the presence or absence of known phases for a given
run, the colour-coding is obtained from two different sources.

If known phases are available...

When a database of known phases were provided to compare the new
samples to, the 'key' on the left hand side of the display shows a list
of those known phases, with the labels shown generated from the
relevant pattern filenames:

Each known phase has a unique colour assignment; and in addition
colours are shown for patterns considered to be either non-
crystalline/amorphous (Amorph.) or unlike any other known pattern
provided (Other).

Each individual pattern that corresponds to a known phase (i.e. one
that gave good matching statistics when being compared to a known
phase) is given the same colour as that known phase - for example, in
the screenshot above, the patterns that matched well to Form B are all
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the same colour of yellow. All of the patterns that match to Form B
can be selected at once by clicking on the colour in the key:

A pie that contains multiple colours (e.g. sample P21 above)
represents a pattern which is thought to be a mixture of two or more
of the known patterns, and the colours within the pie-chart again
correspond to the phases thought to comprise it. Allowing the cursor
to hover over a particular component of a mixture brings up a tooltip
describing which phase and in what amount:
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If no known phases are available...

On the other hand, if no known phases are available what appear to
be similar results are displayed:

However, there are subtle and very important differences. The colour
of the pies obviously no longer correspond to those of known phases,
the colours are now merely representative of patterns which are
similar to each other. In the example above Pies 1, 2, 3 and 4 are
similar to each other as are 5, 6, 7 and 8. Pattern 21 is dissimilar to all
the other samples, as it is a colour not shared by any other samples.

This information is generated from the cluster analysis results as
presented in the dendrogram view (see the next section). As a result
of this, a warning message is displayed that the results shown are no
longer determined separately, but are merely clustering results
presented differently:

Because clustering results are being used, the groups shown are
entirely dependant on the cut-level used on the dendrogram display.
The cut-level is discussed in more detail in Section 2.3.5.1, but it is
important to note that when no known phases are present, altering the
cut-level or otherwise editing the dendrogram display will cause the
cell display colours to be altered and updated accordingly.

This display mode can also be accessed when known phases are
present, by means of the Show Pseudo Cell Display option in the
Display menu.



Results Display
Note that once a particular well is selected, the wells on either side
can be selected in turn by means of the left and right arrow keys, thus
allowing for quickly scanning through multiple patterns.

2.3.5  The Dendrogram

The dendrogram display can be accessed by clicking on the
Dendrogram tab along the top of the display window. 

The dendrogram provides a visual means to display the results of the
hierarchical method of data classification using cluster analysis. The
dendrogram itself takes the form of a tree-diagram in which each
single terminal branch is representative of a single object (in this case
an individual pattern from the data input). 

The initial cut point is set by the program, and is shown by the yellow
horizontal line. Upper and lower confidence limits on this cut-level
are shown with yellow dotted lines where appropriate. 

Each pattern is numbered along the bottom axis of the dendrogram.
Each number is the same as in the other displays - for example,
number 1 on the dendrogram is the same pattern as number 1 in the
cell display.

Each pattern can be selected by clicking on the box above its number.
When a pattern is selected, the sample information along with its
pattern profile is displayed in the bottom half of the display window.
Multiple patterns can be selected by holding down the Control key
and clicking on different patterns.

Note that once a particular pattern is selected, the patterns on either
side can be selected in turn by means of the left and right arrow keys,
thus allowing for quickly scanning through multiple patterns.

The view of the dendrogram can be zoomed in on by dragging a
rectangle over the relevant area with the left-hand mouse button
down as with the graph and cell displays.
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The position of the dendrogram position on the horizontal axis can be
altered by holding down the Alt key and moving the mouse left or
right. This can be useful if the zoom has been used and the whole tree
no longer fits on the screen at one time.

Patterns are joined together by a series of lines. The further up the
similarity axis (y-axis) the patterns are joined, the less similar they
are. Therefore, in the screenshot above, patterns 1 and 3 are joined at
a high level of similarity (nearly 1.0), and are therefore very similar,
whereas patterns 1 and 12 are not joined until a similarity of less than
0.4, indicating a large difference between them.

Given the calculated similarity between patterns, it is then possible to
categorise similar patterns as belonging to the same cluster. This is
done by drawing a horizontal line across the display at a given
similarity level - this is called the cut-level. 

The optimum cut-level is determined by PolySNAP M using a
combination of several different techniques in order to determine the
number of clusters that statistically best represents the data given.
These techniques include principle component analysis, metric
multidimensional scaling, the C-H test, gamma statistics, etc.

The cut-level is then drawn on the dendrogram, and different patterns
which are grouped together below this line are considered to be
similar enough to be thought of as being in the same cluster:

In the screenshot above, the horizontal cut-point is set at around 0.72,
and is therefore considering patterns 1, 3, 2 and 4 to be in one cluster,
whereas 13,14, 15 and 20 are in a separate and distinct one.

The different clusters are colour coded, and if no known phases are
present, these dendrogram results are used to generate a pseudo-cell
display (see Section 2.3.4). In this case the colours used here will
correspond to the colours in that display. Optionally, the same colour-
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coding can be used to help interpret the results in the various 3D
plots.

The Toggle Mode option, accessed through the right-click menu,
redraws the dendrogram with only the first, last and middle patterns
of each cluster shown. This allows easier interpretation of a crowded
display when many patterns are being analysed. Note that while
showing the simplified dendrogram, the cut-level and other
modifications cannot be made. A label is displayed on the top-left of
the display to indicate that the display is in simplified mode.

It is possible to toggle the showing of the axes on and off using the
Show Axes option, accessed through the right-click menu.

2.3.5.1  Modifying the Dendrogram

-Changing the Cut-level

If the program-calculated cut-level is not considered to be correct, it
can be overridden by the user. This is done by holding down the Shift
key and left mouse button, while dragging the mouse up or down.
The cut-line on the dendrogram display will move, and the cluster
colouring will update in real time. For example, moving the cut-level
up to around 0.1 results in the following:

Note that the colour assignations have updated accordingly. If the
user chooses to retain this change when closing the dendrogram
display or switching to another display pane, then the pseudo-cell
display will be updated accordingly, and the modification noted in
the program logfile. If the change is not retained, the previous value
is kept.

[In addition to this method, if a mouse with a scroll wheel is used, it
is possible to just click once in the display area with the left mouse
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button, and then move the mouse wheel up or down to move the cut-
level indicator.]

-Manually changing the contents of clusters

PolySNAP M makes its assignation of the contents of clusters using a
combination of powerful statistical techniques. It should not
normally be necessary to override its results, but for the occasions
when this is necessary, it is possible to reassign either a single pattern
or group of patterns manually.

To do this, hold down the Shift key and click and hold down on the
vertical line attached to the pattern or sub-cluster required to be
moved:

Continuing to hold both the Shift key and mouse button, drag the unit
to the desired location. To add it to an existing cluster, release the
mouse when the cursor is over the area the sample is to be added to:

To create an entirely new, separate cluster, drag it to an empty space
between existing clusters:

To cancel a drag operation part-way through, it is only necessary to
release the Shift key.

A one-step Undo is available for this method of altering the
dendrogram, if for example a user changes their mind, or a cluster is
incorrectly joined. To do this, right click on the dendrogram, and
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select Undo from the pop-up menu. Note that only the most recent
operation can be undone.

The only way to be able to undo multiple operations is to choose not
to save the changes to the dendrogram when closing or switching the
window; that way the original dendrogram will be retained and
shown the next time the results are examined.

When changes to the dendrogram are saved, the changes and the
resulting new clusters and corresponding component patterns are
listed in the program logfile.

2.3.5.2  Saving and Reverting Changes

When another tab is clicked on after the dendrogram has been altered
in one of the ways described above, the following message is
displayed: 

Selecting No will cause any changes to be discarded, and the
previous version of the dendrogram, prior to any manual changes,
will be retained.

Selecting Yes causes the changes made to the dendrogram to be kept,
and also be recorded in the program logfile. Changes to the
dendrogram can also be saved at any point using the Save Modified
Tree option in the right-click menu.

Reverting to a previous dendrogram:

Because the program retains earlier saved versions of the
dendrogram, it is possible to revert to them if required at a later stage.
This function is accessed through the Tools menu option Undo
dendrogram modifications... Selecting this option brings up the
following dialog box. 

If more than one set of changes to the dendrogram have been saved,
the user is offered the choice between the original, program
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generated tree, and the most-recently saved previously modified
version of the dendrogram:

Selecting Cancel retains the current version with no changes.
Selecting Original reverts to the original version. Selecting Modified
causes the current, modified dendrogram to be replaced with the
most recently modified saved changes.

2.3.6  3D Plot (MMDS) 

This option displays the results of metric multidimensional scaling
which make use of distances between objects calculated from the
correlation matrix generated by the matching process to produce a
three-dimensional spatial representation of the samples. Each point
which appears on this spatial representation corresponds to one of the
patterns. The closer two points appear on the plot, the more similar
the patterns are, and the more different an object is to another the
further apart they will appear. Therefore groups of similar patterns
appear to cluster together.

The multidimensional scaling performed is based on calculated
proximities rather then observations. First for n patterns, we generate
an (n x n) distance matrix D based on dissimilarities, δrs = 1,2,....,n,
computed from the correlation matrix. Each object is compared
against itself and every other object. The result of an object being
paired against itself gives a dissimilarity of zero, which corresponds
to the diagonal of the matrix. The goal of this method is to derive a
set of underlying dimensions, with co-ordinates that should create a
Euclidean distance matrix, which in turn should be the same or very
close to the δrs of the original D. 

The initial view of the 3D plot shows only the X and Y axis - the Z
axis lies in projection. 
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In the Display menu, the option Use Dendrogram Colours on 3D
Plots is available. When this item is selected, a check mark appears
next to it in the menu, and the individual points plotted on either of
the 3D plots are coloured to correspond to the colour groupings
shown in the Dendrogram plot - e.g. if samples 11, 12 and 13 are all
in the same cluster according to the dendrogram, they will all be the
same colour - green: 

In the 3D plot, they will all still be coloured similarly:

Changing the dendrogram cut-level causes the colours in the 3D plots
to be updated.. A small numerical label in the top-left corner of the
display gives an indication as to the goodness of fit of these results.
Numbers close to 1.0 suggest that it is a good fit, and low numbers
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suggest that caution may be required, or that the program had trouble
adequately partitioning the data.

Note that as the number of samples increases, the average GOF score
will decrease.

The orientation of the 3D plot can be altered by holding down the
Shift key and dragging the mouse in any direction as desired; the plot
rotates as shown below:

In the above plots it can be seen that there are 4 or 5 clusters
depending on P16 and whether it can be considered to belong to an
adjacent cluster or not.

A variety of views can be achieved to gain a better understanding of
the distribution of the pattern data points in the three-dimensional
space.
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As in the other graphics screens, any particular area of the 3D view
can be zoomed in by dragging a rectangle over the relevant region: 

The powder pattern corresponding to each display point can be
selected by clicking on it, this in turn updates the pattern information
display in the lower portion of the window.

The points representing the patterns can be enlarged or shrunk to suit
any zoom level by holding down the Ctrl key and moving the mouse
either up or down. An upward movement will reduce the size of the
spheres, a downward movement will increase the size. 

The 3D plot position itself can be translated by holding down the Alt
key and then moving the mouse in any direction as required. 

The drawing quality of the spheres can be altered if needed - with
many points plotted, working with the display can be much faster if
the rendering quality is reduced (this is especially the case with
lower-powered graphics cards). To do this, with the 3D display
visible, press the F2 button on the keyboard:

Moving the slider causes the drawing of the spheres to update in real
time, so the effects of a particular setting can be easily seen. The
chosen quality setting is saved and used from that point on. The
higher quality settings can be useful when preparing screenshots for
use in reports or for publication.
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Further options can be accessed by right clicking on the display area
to show the standard pop-up menu. Options relevant to the 3D plot
include:

Find Item... 

This brings up a dialog box allowing a particular pattern of interest to
be located on the display by means of its index number, or label as
appropriate. 

Additional options allow the pattern to become automatically
selected when found - thus updating the pattern information display,
and optionally centred in the display. This is useful when dealing
with large numbers of patterns, as locating an individual pattern of
interest on a crowded plot can be difficult. 

Show Grid - the grid which appears in the 3D plot can be hidden or
displayed. 

Show Labels - the labels which appear next to the plotted points can
be turned on or off with this option. This may aid in seeing an overall
clustering pattern when the display is crowded with many points.
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Show MRM Marks - the Most Representative Member in each cluster
can be highlighted if required with this option. it appears on the
display as a normal pattern with several 'spikes' coming out of it:

These spikes can be hidden or shown by means of this menu option.
Clicking on an MRM sphere brings up a dialog box containing
information about the mean pattern-pattern distance for that
particular cluster. The smaller the distance, the tighter the cluster.

Show Top View - this option brings up a small simplified overview of
the plot in the lower right hand corner. It can be useful for orientating
yourself when zoomed into the display:

Render as Dots and Transparent alter the way the spheres are plotted
as shown in the diagrams below. This can be useful to identify if for
example, a single pattern of one colour is hidden within a group of
another patterns:

Mask Group
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This option is useful in a crowded display with lots of different
clusters overlapping each other - select the Mask Group option, and
the next cluster you click on is temporarily removed from the display.
A key in the top left corner shows the colour of the hidden cluster. To
restore the cluster, deselect the option from the menu. Alternatively,
click on a different colour, and that will be hidden instead. Only one
cluster at a time can be hidden.

With the Mask Group option selected, pressing the spacebar toggles
between hiding the selecting group and showing everything else, and
hiding everything else and showing just the selected group. The left
and right arrow keys can also be used at this point to cycle through
and have each group selected in turn.

Popup Group

This option can be used to bring the whole of a particular coloured
cluster to the front of the display, so it can all be seen at one time. A
key in the upper left shows the colour of the selected group.
Deselecting this option returns the display to normal.

Drag Labels

With this option toggled on, the display is fixed and cannot be rotated
or zoomed. Therefore, it is necessary to use the normal zooming and
rotation controls to select a suitable view angle before selecting this
option. Once selected, all of the pattern labels on the display can be
moved individually by clicking on them and dragging to the required
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new location. This allows for neater diagrams to be created when
required for a report.

2.3.7  3D Plot (PCA)

The plot drawn here is based on the results from principle component
analysis of the modified correlation matrix. The use and interaction
options available for this plot are identical to those for the 3D Plot
(MMDS) described in Section 2.3.6.

2.3.8  Numerical Results

This pane is used to display the pattern correlation matrix. If there are
a large number of patterns then the entire matrix may not fit within
the display, and scroll bars will be displayed along the side and
bottom of the table. 

If the program was run with the Allow Offsets option turned on, an
additional file, correlations_offsets.txt will also be created in the
output folder. The results from it can be seen by selecting a particular
cell, and then allowing the mouse to hover over that cell for a second,
until a 'tool-tip' appears. This contains two numbers in the form
(a0,a1), where a0 is the amount of linear offset applied, and a1 the
amount of non-linear offset applied.

A diagonal line of 1 should be present to show the result of each
pattern matched against itself. Clicking on the 1 for each pattern will
produce the profile and information for that pattern in the relevant
area below. 
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For comparison purposes two patterns can be overlaid on each other
by clicking on a number above or below the line of 1.

For example if 0.2914 is clicked on as highlighted above, the graph
of FORM A (4) and FORM B (2) will be displayed, one overlaid on
the other in the graph pane:

This allows a visual comparison to help decide if the matching results
displayed are sensible or not.

Right clicking on the matrix of results will produce the following
options: 

Clicking on Copy (or alternatively selecting Copy from the Edit
menu) will copy the contents of any selected cells to the clipboard.
To copy only part or all of the results, drag a rectangle over the
desired numbers, a blue highlight region will appear indicating the
numbers selected. Now right click to produce the options and click
on Copy.

Note that the numbers in this window are not editable in any way. 
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The Show Difference Plot... option brings up a new window with a
plot showing the difference trace between the two currently selected
patterns, for example:

2.3.9  View Logfile

The results of the file import, processing, pattern matching,
clustering etc., and any subsequent changes to the results are written
to a file in the output folder named SNAPlog.txt. It is the contents of
this file which are displayed in the View Logfile Pane:

A scroll bar appears on the right hand side of the pane to allow the
user to view all of the text, as the output is normally quite long. 

The text can be copied to the clipboard and pasted to other
applications by selecting the relevant text to highlight it and then
right-clicking in the text pane:
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Click on Copy to copy the text (alternatively choose the Edit menu
and click on Copy). Note that the Cut and Paste options are
unavailable, as the logfile cannot be edited manually.

The Save As... option causes a standard file saving dialog box to
appear

This allows a copy of the current logfile to be saved to a new file.
Select the desired location for the file, edit the filename if required.
The format for saving is an ASCII text file (*.txt)

The Print... option brings up the standard Windows print dialog box,
allowing the current selection of the logfile output to be printed. 

2.3.10  Other Display Tools

2.3.10.1  List Non-crystalline Patterns...

This option, accessed through the Tools menu, allows the user to
examine a list of any patterns that the program has marked as being
possibly non-crystalline when it has examined them.
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Selecting it brings up a display window:

The upper region is a grid showing the pattern names, number of
peaks, and approximate percentage amorphous content. The larger
this value, the more likely the pattern is to have an amorphous
content.

Selecting a pattern in the list (by clicking on it once) updates the
profile display in the lower region of the window to show what the
pattern profile actually looks like. If the Show area used for
amorphous indicator calculation checkbox is selected, then a second,
green trace shows the rough profile that would be left if the program
subtracted out everything it thought was amorphous from the pattern.

If the user considers that the program has made an error in marking a
particular pattern as non-crystalline, they may override this by
clicking the Unmark button on the lower left. This action is recorded
in the program logfile.

It is also possible to do the opposite, and mark a pattern as
amorphous; for information on how to do this, see Section 2.3.2.2.
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2.3.10.2  List Mixture Patterns...

Selecting this option from the Tools menu brings up a new window:

This consists of an upper region listing all of the patterns marked as
mixtures, and a lower graph-pane region. Selecting a particular
pattern from the list causes it to be displayed in the graph pane, and a
list of which known phases are thought to make it up are listed in the
display area. Clicking the Residual button opens a PolySNAP M
window to allow comparison of a simulated pattern created from the
suggested phase components, and the original sample.

N.B. this option is only available when powder patterns for known
phases were provided.

2.3.10.3  List Pattern Cluster Members...

This option is available only when the dendrogram is being
displayed, and generates a list of the current members of each cluster
suggested by the cluster analysis, according to the current saved
dendrogram cut-level. 
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If the list of cluster members is short enough, it is displayed as a
message box, which can then be dismissed:

If the list of members is too long for a standard message box, it is
automatically added to the end of the program logfile, from where it
can be copied into a report or other program as required.

2.3.10.4  Export Pattern Clusters...

This option brings up a dialog box allowing the list of pattern clusters
to be saved to a text file for use elsewhere.

2.3.10.5  List Most Representative Patterns...

This option is only available when either the MMDS or PCA plots
are being displayed. Note that the calculation of MRPs is specific to
the type of plot displayed, so different results may be obtained from
each of the two methods. Different results will also be obtained if the
dendrogram cut-level is adjusted manually.

A list of the pattern indexes and filenames for the most representative
patterns in each cluster to have 3 or more members is shown in a
dialog box on the screen. A copy of the list is also automatically
added to the logfile when this option is selected.
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2.4  Other Menu Items

Close Window in the File menu closes the automatic analysis results
window. The user will be asked if they wish to retain any unsaved
changes to either the dendrogram.

The Edit menu, in addition to giving access to the standard text
editing controls (Cut, Copy, Paste, etc.) also allows access to the
program defaults and preferences through the Options item.

The Window menu contains the following items:

Window List (submenu)

This submenu lists all of the currently open windows within the
PolySNAP M program. Selecting a window from the list brings it to
the front.

View Error Log

This option opens a new window containing an edited version of the
PolySNAP M logfile, which contains only lists of errors or problems
that have occurred during a run of the program:

It may be a useful aid in the determination of where any problems are
occurring.



Other Menu Items
View/Edit Reference Database

This option opens the current database of known or reference
patterns (if present) in a standard PolySNAP M database window:

It can then be examined, edited or used as a basis for a manual match
or analysis procedure as required. For more details see section 3.4 on
page 92.

View/Edit Sample Database

This option opens the current database of imported patterns in a
standard database window. It can then be examined, edited or used as
a basis for a manual match or analysis procedure as required.

The Help menu contains the following relevant items:

View Manual

This option opens a new window containing a PDF version of this
manual that can be searched, displayed or printed as required.

About PolySNAP M
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Selecting this menu item brings up a screen describing the running
version of PolySNAP M, and includes useful information such as the
version number and build date:



Output Files
2.5  Output Files

An average run of PolySNAP M creates a variety of different files in
the selected output folder. This section lists and describes the most
important of them:

Run_xx-yy-zz.par

This is the database file containing copies of all of the original data
files. It can be opened and examined manually in manual analysis if
required. The file was created on the date xx-yy-zz.

Known_phases_xx-yy-zz.par

This is the database file containing copies of any individual known
phase files. It can be opened and examined manually in manual
analysis. This file only appears if known phases are being used, and
they are not already in a database file. The file was created on the
date xx-yy-zz.

SNAPlog.txt

This file is added to continually while the program is running. It
consists of a record of program operations and any user alterations to
the program-generated results. It can be viewed from within the
program, or in any text editor.

Errorlog.txt

This file is a very abbreviated version of the logfile, containing only
records of problems or difficulties encountered during data import,
processing, or pattern analysis. It can be viewed from within the
program, or using any text editor.

correlations.txt

These files contains the numerical values from the sample matching
process, where every individual pattern is compared to every other
pattern. It is these numbers which are displayed in the Numerical
Results pane of the Display window. Values can also be examined by
viewing this file in a spreadsheet program such as Microsoft Excel.

Dendrogram.dat Dendrogram_modified.dat

Dendrogram_original.dat Dendrogram_disused.dat

The output file containing data for the dendrogram display is saved
as Dendrogram.dat. If the user then makes and saves changes to the
dendrogram, the original output file is renamed
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Dendrogram_original.dat. If further changes are made and saved, the
previous version of the file is renamed Dendrogram_modified.dat.
Should the user later choose to revert to an earlier version of the
dendrogram, the appropriate file is renamed to Dendrogram, and the
current, unwanted version renamed as Dendrogram_disused.dat.
Both Dendrogram_disused.dat and Dendrogram_modified.dat retain
only the most recent changes, and may be overwritten. The original
results file is never overwritten, and can be returned to at any time.

Pie.dat and Pseudo_pie.dat

If known phases were provided, Pie.dat contains information used by
the cell display to show colour-coding and mixtures compared to
known-phase patterns. If no known phase files were provided,
Pseudo_pie.dat contains the current dendrogram groupings
reformatted for display in the cell context. If filename information
was used to label the cells with the correct well identity number, then
an additional file pie_index.dat is used to store the original output
file.

mmds.dat and mmds_coloured.dat

This file contains display information used to display the 3D
(MMDS) plot, using either the default colour scheme (3dmmds.dat)
or the colour scheme utilised by the current saved version of the
dendrogram (3dmmds_coloured.dat).

pca.dat and pca_coloured.dat

This file contains display information used to display the 3D (PCA)
plot, using either the default colour scheme (pca.dat) or the colour
scheme utilised by the current saved version of the dendrogram
(pca_coloured.dat).

QuantitativeResults.dat  correlations_offsets.txt

The first file contains the output from the quantitative analysis of any
suspected mixture patterns. The second file contains the output of the
best calculated shift for each pattern matched.

amorphous.dat    membership.dat

mmds_na.dat       pca_na.dat 

Various files ending in .tmp

These are various internal files used by the program.



CHAPTER 3 Using PolySNAP M: Manual
Analysis
3.1  Database and File Handling

In order to use PolySNAP M in manual analysis mode, the user must
first either create a new, empty database and load some patterns into
it, or open an existing database. This chapter describes both these
processes.

3.1.1  Database creation

Having launched the program, select New Database... from the
Manual Analysis section of the File menu.

A standard Windows file dialog will appear:
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This will initially suggest the filename processed.par and a location
at the root directory of the C:\ drive. The filename and location can
be changed in the normal Windows manner.

Note that the .par suffix indicates the database being is saved in the
standard PolySNAP M database format.

Once created, the database will be opened in a new window:

The top portion of the window provides some basic information on
the database, including its name and location, and the number of
patterns stored in it. Initially, of course, it is empty. 

The central portion of the window will list the patterns included in it.
It will be described in more detail on page 70.

The lower region consists of 5 buttons, used to access the main
functions of the program. The buttons all have corresponding entries
in the program menus.

3.1.2  Opening an Existing Database

To open a pre-existing database, select Open... from the File menu. A
standard Windows file browser will appear. Locate the database, and
either double-click on it, or click once to select it, and then click the
Open button.
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A database window will open, and the patterns loaded. Depending on
the number of patterns in the database, this may take some time.
Progress is indicated via a progress bar at the top of the window:

3.1.3  Default Databases

If you commonly open the same database each time you launch the
program, this process can be speeded up by defining the path of your
database as the program’s default. This can then be opened directly
by use of the Open Default option in the File menu, or by the
keyboard short-cut Option-D. 

The default default database is C:/processed.par. This can be
changed in the Program Options dialog, accessed through the Edit
menu’s Options... entry.

3.1.4  Recent Databases

The four most recently opened databases are stored in the Recent
Databases submenu for easy access. Selecting one of the entries
automatically causes that particular database to be re-opened.

Note that if you have moved the file since it was last opened you will
have to open it manually.
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3.1.5  Importing Files into a New Database

Once a new, empty database has been created and opened, the next
stage is to import some patterns into it. This is achieved by clicking
on the Import... button at the bottom of the database window (or
using the Alt-I short-cut, or choosing Import Patterns... from the File
menu).

A standard Windows file selection dialog will appear, and either
single or multiple pattern files can be selected for import. Multiple
files of different types can be easily selected using the shift or option
keys, or by dragging the mouse across the names to select them.

Click Open to begin the data importation process.

This version of the program can import pattern files in one of 4
formats:

3.1.6  Text files (filename.txt) (filename.prn)

These should be standard ASCII text files. The angle should be the x
data, and the corresponding intensities the y data. The x-y data must
be in the format:

x1 y1
x2 y2
. .
. .

etc. 

The fields must be tab-delimited.

If the first line in the file begins with either a '#' or the string 'ID: ', the
rest of that line is used as the 'Pattern Name' for the pattern.

Any subsequent lines beginning with the '#' character are ignored.

3.1.7  Comma-separated value files (filename.csv)

These should be standard ASCII CSV files, containing the x-y data in
the format:

x1,y1
x2,y2
.,.
.,.

etc. 
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If the first line in the file begins with either a '#' or the string 'ID: ', the
rest of that line is used as the 'Chemical Name' for the pattern.

Any subsequent lines beginning with the '#' character are ignored.

3.1.8  CIF (Crystallographic Information Format) files             
(filename.cif)

The program contains a CIF-format translator that reads standard
version 2.0 Powder CIF files. Although the only data necessary for
SNAP is the x-y intensity data, the rest of the CIF information - such
as chemical names and formulae, author names and addresses etc. are
also retained in the database for reference purposes, and may be
viewed from the Pattern Editor window (see Section 3.3.1).
Additionally, unit cell dimensions and contents are read in if present
for use in Quantitative Analysis mode.

For more information on CIF format files, see the IUCr website at:

http://www.iucr.org/iucr-top/cif/pd/index.html

3.1.9  Bruker Raw Format files

The program can import data from Bruker RAW format. This is a
binary file-format, so cannot be edited or viewed in a conventional
text editor. There are several different types of RAW format; PolyS-
NAP M should be able to import all versions up to Version 4. 

Although the only data necessary for PolySNAP M is the x-y inten-
sity data, much of the rest of the information stored in the file - such
as chemical names and formulae, author names and addresses etc. are
also retained in the database for reference purposes, and may be
viewed from the Pattern Editor window (see Section 3.3.1).

3.1.10  PolySNAP M Pattern files (filename.pat)

Patterns in PolySNAP M databases can be individually exported in
the program’s own .pat format. This format contains the original x-y
raw data, any processed data - e.g. the profile after noise removal,
marked peak positions and any other data fields present. Once saved
as separate files, they can then be re-imported to the same or a
different database at a later date.
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3.1.11  Processing

Once files have been selected for import, a dialog box will then
appear, informing you how many patterns will be imported, and
offering several data processing options:

Normally, the default settings at this stage are to perform all three
options:

• Background subtraction

• Smoothing and noise removal

• Peak finding. 

All of the processing choices are optional, although in order to
perform basic matching operations, at least the main 'Normalise
intensities (required for matching)' checkbox should be selected. 

Selecting OK will begin the import process. 

A progress bar indicates progress through the processing:

If any selected patterns cannot be loaded - for example if they are not
in the correct format, or a file is corrupted, a warning will be shown:
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In such a case, the rest of the selected patterns should still load
correctly.

Once the import procedure is completed, the list of patterns
contained in the database will appear in the centre of the database
window:

Each entry in this list corresponds to one imported pattern. The left-
most column contains the pattern name or ID associated with that
pattern, if one is known. (This is either read from the CIF data field if
present, or can be entered manually in the pattern editor - see Section
3.3.3) If no name is known, this column shows the filename.

The rightmost column lists the filename from which each pattern was
loaded.

3.1.12  Sorting Database Entries

Initially, this list of patterns is shown in the order that patterns were
added to the database. It is often more useful to see the list of patterns
sorted in order of either chemical name/ID, or individual filenames.
This is done by clicking once on the relevant column header.
Clicking again on the same header will reverse the order of the
sorting, e.g. from ascending to descending, or vice versa.

3.1.13  Exporting patterns

Individual patterns contained within a PolySNAP M database can be
exported to either text or pattern format files, for easy viewing or
editing in other programs, or for transferring to other PolySNAP M
databases. This means PolySNAP M can be used as a general
purpose pre-processing tool for patterns that are to be used in other
programs.
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Click once on the pattern you wish to export. It should become
highlighted in the list:

Then click once on the Export... button (or use the Export... option
under the Pattern menu). A standard file saving dialog box appears:

Select the desired location for the file, and edit the filename if
required. The default format for export is a .pat pattern file, but a .txt
text file format option can also be selected from the Save as type
drop-down menu at the bottom of the dialog box.

Click Save, and the file will be saved to the chosen location.

Note: This process saves a copy of the selected pattern to a separate
file, it does not remove the original pattern entry in the database.

This option saves the processed version of the pattern (i.e. the
version with smoothing, background subtraction etc. applied) if one
is present, so if the raw pattern is required, remove any processing
using the Edit window before exporting.
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3.1.14  Removing Patterns

Select the pattern or patterns you wish to delete from a database.
They should become selected in the list:

Then click once on the Remove button (or select Remove from the
Pattern menu, or press the Delete key on the keyboard). A warning
appears:

If you change your mind, select No. Selecting Yes removes the
selected pattern(s) from the database permanently. To retrieve them,
you would then have to re-import the pattern from the original data
file. (The original data files are not affected in any way by the
Remove command.)
73



74
3.1.15  Viewing and Editing Patterns

Click once on the pattern you wish to examine. It should become
selected in the list:

Then click once on the Edit button (or select Edit Pattern from the
Pattern menu).

The Pattern Editor window should appear. This is described in detail
in section 3.3.1 on page 76.

3.2  Matching and Analysing Patterns

If you have a new, unknown pattern you wish to analyse or compare
to entries in an existing database, the first step is to import the new
pattern to the existing database.

Having done this, select it in the list of patterns, and click Match (or
select Open in Match Window from the Pattern menu).

The matching window is described in detail in Section 3.4, Pattern
Matching and Analysis.

3.2.1  Refresh Database

This feature is accessed through the menu item Refresh found in the
Manual Analysis section of the File menu. This option updates the
local copy of the database in memory by reloading all pattern
information from the copy on disc.

3.2.2  Save Copy of Database

This feature, accessed through the Save Copy of Database... Menu
item located in the Manual Analysis section of the File menu, brings
up a standard Windows Save As file dialog. The process asks for a
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new database name, and copies the pattern contents of the existing
database into the new one. Note that you cannot use the existing
database name as that file remains open during the process.

Once completed, the resulting database will be saved with the name
selected and can then be opened by PolySNAP M in the usual
manner.

3.2.3  Apply Processing to Database

This feature is accessed through the Tools menu item Apply
Processing...

If you wish to change the way in which all of the patterns are
processed at once, it is possible to do so without having to change
them individually, or having to re-import them from the original files.

Select Process, then select the new required processing options as
required from the resulting dialog:

The selected processing will then be applied, which for a large
database may take some time.

3.2.4  Mask Regions

This option, accessed under the Tools menu, is used to mask a
particular region of the diffraction pattern to zero for every pattern in
a database. (For more information on masking regions, section 3.3.10
on page 86) 

Selecting this option brings up a window which asks for the start and
end angles of the region to be masked:
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Enter the values, and click Apply. The region selected will be set to
zero for all of the patterns in the current database. Depending on the
size of the database, this may take some time. 

Multiple regions can be masked by repeating this process.

Note that applying any additional processing to a pattern after this
point will remove any masked regions. Masking can be re-applied or
changed for an individual pattern in the Pattern Editor (see Chapter
3).

To remove all masking from all patterns for a particular database,
select the Mask Regions menu option, and click the Reset All button.
Again, this may take some time.

3.3  Pattern Editing and Processing

3.3.1  The Pattern Editor

After selecting a pattern in the database, and selecting the Edit
option, the Pattern Editor window will appear:
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Note that while the editor window is open, no other changes can be
made to the open database.

The File menu option, Close Window, closes the editor and returns to
the main database window. (The same result is achieved by clicking
the close box on the titlebar of the window.) If any changes to the
pattern have been made, a dialog box will appear asking if those
changes should be retained or not:

Selecting Yes saves the changes and returns to the database listing
window, No discards any changes made and Cancel returns to the
Pattern Editor.

One of the other File menu option available, Export..., performs the
same function for the pattern currently being edited as the Export...
button in the main database window. Selecting it causes a standard
file saving dialog box to appear:

Select the desired location for the file, and edit the filename if
required. The default format for export is a .pat pattern file, but a .txt
text file format option can also be selected from the pop-up menu at
the bottom of the dialog box.

Click Save, and the file will be saved to the chosen location.

Note: This process saves a copy of the selected pattern to a separate
file, it does not remove the original pattern entry in the database.

This option saves the processed version of the pattern (i.e. the
version with smoothing, background subtraction etc. applied) if one
is present, so if the raw pattern is required, remove any processing by
turning off all processing options and clicking Process before
exporting.
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Finally, the option Export Peak List brings up a save dialog box,
allowing the peak list for the current pattern to be saved to an ASCII
text file for use in other programs.

3.3.2  Graph Pane

The lower part of the window, where the pattern is displayed, is
called the graph pane:

The x-axis is normally displayed as a 2θ range and the y-axis an
intensity. For positive data, all values are normally scaled to between
0.0 and 1.0 for use in PolySNAP M, unless no processing has been
performed at all upon the data.

Individual peaks in the graph pane are marked by peak markers,
which are seen as a single large dot at the top of the peak. (For more
information on peak markers, See “Find Peaks” on page 84.) 

Clicking and dragging to draw a rectangular box on the graph pane
using the left mouse button causes the graph to zoom in into the
selected region, for example:

It is possible to zoom in repeatedly using this method. Clicking on
the graph with the right mouse button causes a pop-up menu to
appear:

Options in this menu are:

• Reset View - selecting this after the graph scale has been changed
returns to the default zoom level.
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• Remove Peak - if the click was in the vicinity of a marked peak,
the marker will be removed.

• Add Peak - the nearest maxima to the click location is marked as a
peak on the graph.

• Set Peak Threshold - sets the y-value of the current mouse posi-
tion to the minimum allowed peak height.

The same options are also available from either the Graph or
Pattern menus respectively. The central region of the Pattern Editor
contains the pattern information controls in two tabs: Basic and
Advanced.

3.3.3  Basic Pattern Information

At the top left corner is the pattern name/ID text box. If no name has
been read in for the pattern from the data file, this will normally read
"(Unknown)". This name can be edited by clicking in the text box,
and deleting or adding text as required. It is recommended that
pattern names do not exceed 256 characters. Standard text-editing
commands, such as Cut, Copy and Paste are all available from the
Edit menu. This field is used by default to identify different patterns
in the database and match windows.

Below this is the Formula field, which is also an editable text field. If
formula information is present in the datafile, it will be read in and
displayed automatically. Otherwise, it would need to be entered
manually. This field is not required for operation of the program, but
may be useful for reference.

Below that is a text field displaying the path and filename of the
original data file the pattern was obtained from. If this path is longer
than 100 characters, it will be truncated, and only the right-most 100
characters will be displayed. To see the entire path, leave the mouse
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cursor hovering over the text for a few seconds to see a 'tool tip'
containing the full path. 

Next is the range the current pattern spans on the x-axis (normally in
degrees.)

Following this is the number of raw data points in the pattern: this
corresponds to the number of data points read from the original data
file. 

The number in brackets after this is the resolution of the raw data
calculated using:

 (End angle - Start angle) 
No. of raw data points

This corresponds to the magnitude of the x-difference of the
difference between two adjacent data points.

Next to this is a similar indicator for the processed data. The
processing referred to is the basic processing undergone by every
pattern imported into a PolySNAP M database. This involves scaling
the intensity data between 0.0 and 1.0, and interpolating the data
(using 5th order polynomials) so that all of the patterns in the
database are the same standard data resolution. This is normally 0.02
degrees per datapoint, or 50 data points per degree. 

Below this is noise indicator for the pattern calculated in the wavelet
domain, using the MAD estimator (see section 3.3.8, References). A
larger number corresponds to a more "noisy" pattern.

The wavelength field reads in a value for the wavelength at which the
data was recorded, either from a CIF or RAW data file. If another
import format was used, or the information was not present in the
file, the default value is used. In this situation, the legend 'Default
Used' appears next to the wavelength value to warn the user that it
may require to be changed manually.

This can be done by either selecting a standard value from the
scrolling list, or by choosing the 'Custom' option at the bottom of the
list of choices, and entering a numerical value in the adjacent text
box. The pattern display is updated for a new standard wavelength
immediately, and for a custom one after the changes to the pattern
have been saved.
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The final pattern information display only appears when the pattern
is being edited was originally imported from a CIF or RAW data file.

Any other data fields that were imported with the data are able to be
examined via the list obtained by clicking on the small disclosure
triangle:

Only the first line of each data field is displayed in the list; if viewing
of a multiple line field is required (for example, an author’s address),
select it from the list. A button will be enabled beside the pop-up
region, labelled Details: 

Clicking this produces a dialog box containing the full text of the
field:

The final region of the of this pane contains the pattern processing
options:

Although patterns will normally have been processed automatically
upon import, it is easy to override those general processing options
for an individual pattern using these controls.
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The operation of these controls maybe most easily illustrated upon a
pattern that had no processing performed upon import. Such data
would look something like the diagram below:

A raw data plot is generally shown in green on the graph pane when
processing has been applied. Blue represents the processed profile. It
is this processed profile that is used throughout the rest of the
program for matching and analysis.

3.3.4  Background Subtraction

Checking the Subtract Background option under Processing Options,
followed by clicking the Process button, causes a second pattern to
appear on the graph pane, generally in blue:

This is the same pattern as the raw data one, but with any unwanted
background removed. This process is achieved by best-fitting several
linked polynomials to the base of the raw data pattern, and then
subtracting them from it.

If results from this are unsatisfactory, this processing option can be
switched off by simply unchecking the box, and clicking the Process
button again.

If the actual curve that has been subtracted is required to be
examined, select the Show Background Curve option in the Pattern
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menu. A new window opens, and the calculated background region is
then outlined in blue above the green raw pattern data. 

The same pattern with background subtracted:

3.3.5  Smoothing

Selecting the Smooth option, and clicking Process causes the pattern
to be smoothed using a wavelet-based SURE thresholding procedure
(see section 3.3.8, References). This allows obvious noise to be
removed without the loss of small or fine peaks.

For example, a detail is shown below of the same region of the same
pattern, before and after smoothing has taken place.

The upper green line is the original unsmoothed profile, and the
lower blue is the same after smoothing has been performed.

To alter the amount of smoothing applied to the individual pattern
being examined, move the slider to the right to increase, or to the left
to decrease it. The display is updated automatically.
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The amount of smoothing performed by default can be controlled by
changing the 'Smoothing Factor' value in the program Options
dialog.

3.3.6  Find Peaks

Finally, selecting the Find Peaks option, followed by clicking the
Process button tells the program to use a simple first-derivative peak
search algorithm to locate the main peak maxima in the pattern.
These are then marked with coloured circles on the graph pane.

For example:

In order to stop small, unwanted peaks being marked, a peak
threshold level can be set, via the slider on the right hand side of the
window:

The default value is 0.05, meaning that no peaks will be marked
below 5% of the maximum peak height. A global default value for
the peak threshold can be set in the Options dialog (see Chapter 4.6,
Matching Options). This value is used when processing multiple
patterns automatically on import. Changes made to the threshold
level in the pattern editor override the global value for the individual
pattern in question.

For example, note the differences in the number of marked peaks for
the same pattern as above, but with the peak threshold level set to
zero:
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Individual peak markers can be removed by clicking on them once to
select them (a differently coloured border will appear round the spot
on the graph pane), followed by either clicking the Remove Peak
button, or by selecting the Remove Peak option from the Pattern
menu. After a peak is removed, the peak immediately to the right of it
becomes automatically selected.

It is also possible to remove a peak by clicking on its entry in the
Peak List box to select it, and then clicking the Remove Peak button.

The number of peaks field reports how many points in the pattern
have been marked as peaks. These are shown by round dots on the
profile displayed on the graph pane.

A scrolling list of all the marked peaks showing their x-position and
corresponding y-value is displayed on the right-hand side of the
pattern editor window:

Clicking on a particular peak in this list causes it to become selected,
and the corresponding peak marker to be highlighted on the pattern
itself to aid in identification.

3.3.7  Notes on processing

Although the processing options (such as subtracting the
background) can be made on a pattern by pattern basis, best results
are obtained in the matching and analysis sections of the program
with databases whose constituent patterns are all processed in a
consistent manner. For example, two otherwise identical patterns
may appear very different if one has been smoothed and background-
subtracted, and the other has not. Consistency in how patterns are
processed generally leads to the best matching and analysis results.

3.3.8  References

Wavelet SURE thresholding is discussed in:

Donoho, D.L.; Johnstone, I.M.; (1994). Adapting to Unknown
Smoothness via Wavelet Shrinkage. Technical Report, Department of
Statistics, Stanford University.
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3.3.9  Advanced Pattern Information

The advanced tab has two main regions: one allowing the ability to
mask sub-regions of the pattern, and the other to enter additional
information and thus calculate various constants for the pattern.

3.3.10  Masking

The upper section in the advanced pane contains the controls to mask
selected regions of a pattern.

If a pattern contains a spurious peak or unwanted standard, or for
some reason the user wishes to only compare a certain region from
the pattern, this option allows a chosen sub-range to be set to a
particular value. (This is generally zero, although non-zero values
may be useful when a high background signal is present.)

To use this option, first decide on the angle range to be masked. Enter
the start and end angles in the relevant boxes. The value in the
magnitude box sets the signal to that value over that range.

Masked regions can also be applied in one step to every pattern in a
database using the Mask Regions... option. This can be found under
the Tools menu, when the database window is frontmost. See Section
3.2.4, Mask Regions.

In the example below, the user wishes to mask the central of the three
main peaks:

As it is at approximately 35° 2θ, the start angle could be 34°, and the
end angle 36°. There is no noticeable background, so the mask value
can remain as zero.
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Clicking the Apply button results in the following:

Notice that the peak is still visible in green. This shows that the
original data - the unprocessed pattern - has not been modified.
However, there is no peak visible in blue - it has been removed from
the processed pattern. It will not appear in the Match window or
other regions of the program which only make use of the processed
pattern profile.

Multiple regions in the same pattern can be masked by repeated
application of the same technique.

To reset all masking, and make the processed profile available again,
click the Reset All button. The same effect is obtained by re-
processing the pattern using any of the standard controls in the Basic
tab.

3.3.11  Additional Pattern Information

This section of the pattern editor contains fields for entering other
information that is known about the sample.

This information is used to calculate various useful constants and
numbers about the pattern. The information calculated here is
required if you wish quantitative analysis to return results as a weight
fraction. 

The first time the Advanced tab is used for a pattern, the Unit Cell
Contents field is taken to be the same as the Formula field from the
Basic tab. However, they are saved separately in the pattern, and
changes to one do not affect the other. The Formula field is
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completely free format, whereas the Unit Cell Contents field has a
fairly strict format, as described below.

The unit cell contents should be entered in the form:

<Atom Symbol><No. of that atom><Space or comma><Next atom symbol ... etc. 

For example, the following entries would be valid:

C3 H8 02
C3,H8,O2
Al O3 H
c3 H8 o2

Non-integer values are permitted.

The following entries would not be valid, for the reasons described:

C 3 H 8 O 2 

-has spaces between the element types and the number.

C3H8O2

-has no spaces at all between each separate entry!

Al(OH)3

-Contains brackets.

Any invalid entries should result in an error: 

Note however that it is possible to enter a string that does not
generate an error message, but that does not produce correct results.
For this reason, entries in this field should be checked carefully. Also
please note that entries are not checked for chemical sense during
calculation.

The field Z represents the number of formula units per unit cell. It
should be a numerical value greater than zero. It can be non-integer.

The fields for unit cell dimensions ( a, b, c, α, β, γ ) all expect
numerical non-zero entries. The angles should be in degrees, and the
lengths in angstroms (Å).
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Once all known information is entered, click the Update button.
Depending on what information was provided, some or all of the text
fields at the bottom of the pane will update with new values.

For example, with the following information entered:

Clicking Update results in the following results:

As in this case all of the fields have been successfully calculated, this
pattern could potentially be used as part of a quantitative analysis
resulting in a weight fraction being calculated.

3.3.12  Additional Calculation Information

For reference, the items above are calculated as follows:

• Unit Cell Volume:
Given unit cell lengths a, b and c in Å, the volume V is then:

• Density:
Given the molecular weight MW in atomic mass units, the num-
ber of formula units per unit cell Z, and cell volume V in cubic
angstroms, the density ρ may be calculated by:

• Linear Absorption Coefficient:
Given the cell volume Vc, and the total photon interaction cross-
section σi in barns/atom for each atom in the unit cell, the linear
absorption coefficient µ  is calculated by:

• Mass Absorption Coefficient:
This is calculated by dividing the linear absorption coefficient µ
by the density, ρ:

µ∗ = µ / ρ

ρ MW Z 1.66××
V------------------------------------=

1

1 n

i
iVc

µ σ
=

= ∑
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• The database of atomic information is contained in the file
SNAPdb.dat, which should be located inside the folder containing
the SNAP.exe program itself. The format is discussed below:

3.3.13  Atom Info Database Format

There are 11 lines per entry:

Line 1: Format(a3,i4,2x,a12)
Element symbol, charge or oxidation state, full element name

Line 2,3: Format(6f12.6/6f12.6) 
X-ray atomic scattering factors in parameterised form: 
        a1     a2        a3     a4     a5     c   
       b1     b2      b3     b4    b5     0

 Sources:
 - Fit parameters of all atoms/ions (with the exception of O1-)
from publication "New Analytical Scattering Factor Functions
for Free Atoms and Ions", D. Waasmaier & A. Kirfel, Acta Cryst.
1995, A51, 416-431)

 - Fit for O1- based on the tabulated values of Table 2 (D.Rez, P.
Rez & I. Grant, Acta Cryst. (1994), A50, 481-497). 

- Fits for all other atoms/ions based on the tabulated values of
Table 6.1.1.1 (atoms) and Table 6.1.1.3 (ions) (International
Tables for Crystallography, Vol. C, 1992)]
f(atom)=a(1)exp[b(1)]+a(2)exp[b(2)]+a(3)exp[b(3)]+a(4)exp[b(4)]+a(5)exp
[b(5)]+c]

Line 4: Format(f12.6)
Neutron scattering cross section.

Line 5: Format(i6)
Flag for the source of the electron scattering factor.
[In some cases, values for atoms have been 'filled in' for ions. In
this case the key is the same except the flag is negative (e.g. flag
is -1 if have used scattering factors for a neutral atom from Smith
& Burge for an ion).]

Line 6,7: Format(5f12.6/4f12.6) 
Electron scattering factors in parameterised form:
        a1 b1 a2 b2 a3 b3 a4 b4 c
 f(atom)=a(1)exp[b(1)]+a(2)exp[b(2)]+a(3)exp[b(3)]+a(4)exp[b(4)]+c
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Line 8: Format(7e12.4) 
µ ( for the following radiations:
        Ti,Cr,Fe,Co,Cu,Mo,Ag
All ions have the same µ value as the neutral element. µ values
are taken from International Tables Volume C 193-199

Line 9: Format(7f12.6) 
df'  for the following radiations:
        Ti,Cr,Fe,Co,Cu,Mo,Ag

Line 10: Format(7f12.6) 
df'' for the following radiations:
         Ti,Cr,Fe,Co,Cu,Mo,Ag
All ions have the same df' and df''  as the neutral element. df' and
df'' are taken from International Tables Volume C 219-221.

Line 11: Format(2f12.6) 
Covalent radius, van der Waals radius.

Note: Many Covalent radii and most van der Walls radii are 
approximate. The ions are given the same van der Walls radii as 
the neutral atoms. For heavy atoms there is very little knowledge 
of these parameters

In addition to the items specified above, information is taken 
from the following sources:
1. “New Analytical Scattering Factor Functions for Free Atoms 
and Ions”, D. Waasmaier & A. Kirfel, (1995) Acta Cryst. A51, 
416-431.

2. Rez, D, Rez, P. & Grant, I, (1994) Acta Cryst. A50, 481-497.

3. Smith, G.H. & Burge, R.E. (1962) Acta Cryst. 15, 182-186.

4. Doyle, P.A. & Turner, P.S. (1968) Acta Cryst. A24, 390-397.

5. Jiang, J.S. & Fang-Hua, L. (1984) Acta Physica Sinica 33, 
845-849

6. A Bondi, (1963) J. Phys. Chem., 68, 441-51. 

Note: The 'Format' described above refers to Fortran-style fixed 
format numbers. For example if the format is (3I4,2F8.2), the 
program expects to find 3 integers, each of 4 characters, followed 
by 2 floating point numbers, each of which total width 8 charac-
ters (including the decimal point, with 2 places after it).
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3.4  Pattern Matching and Analysis

3.4.1  The Match Window

After selecting a pattern, and clicking the Match option, the Pattern
Matching window appears:

The two main active modes of the program are accessed from this
central window.

3.4.2  Graph Pane

The pattern being matched appears in red the graph pane in the lower
part of the window. It can be zoomed in and out in the same manner
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as in the Pattern Editor, by using the mouse to drag a rectangle over
the relevant area:

3.4.3  Results Pane

The central part of the window is a scrolling list where any matching
results are displayed. This results pane contains, from left to right,
the following fields:

The first field contains the number of the pattern, where No. 1 is at
the top of the list. Clicking once in this leftmost column for a
particular pattern entry results in a coloured dot appearing, and the
corresponding pattern being shown in the graph pane, superimposed
upon the matched pattern. The spot is the colour the pattern is
displayed on the graph pane. 

Clicking the same column again removes the pattern from the graph
pane.

The next field is the Name/ID field. This normally shows the
chemical name, but if this is "(Unknown)", it shows the short-
filename of the pattern instead.
93



94
Next is the Rank value calculated for each pattern. This is obtained
by summing the results from the four different matching tests, in a
user-defined manner. By default the two are combined in a one to one
ratio - see Section 3.4.8.2, Rank Weightings.

The Parametric field displays the result of the parametric correlation
coefficient.

The Spearman field displays the result of the Spearman non-
parametric correlation coefficient.

The Kol-Smir field displays the result of the Kolmogorov-Smirnov
non-parametric statistics test.

The Para Peaks field displays the result of the parametric correlation
coefficient, applied to marked peak regions only.

These individual tests are described in detail later.

The first two tests are applied to the entire full profile (i.e. every
single datapoint) of each entry in the database. Consequently, they do
not require any peak markers to have been located in the individual
patterns. The last two tests are performed only upon individual
marked peaks that coincide between the sample and database
patterns.

3.4.4  Status Bar

Above the results field is the Status Bar display:

The left side of this displays any status messages or errors. The right
hand side consists of a progress bar. This indicates how far through
the matching process the program is at any one time.

3.4.5  Mode-independant Controls

The upper-right portion of the window contains the matching
controls. These are common to all of the operational modes:

Information display:
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The top section contains the chemical name for the selected pattern
(if known). The Edit button allows direct access to the Pattern Editor
for the current pattern. This means that, for example, peaks could be
added or removed at this stage.

The bottom section shows the name and location of the database the
user is matching the unknown pattern against.

If either of these are too long to be displayed in the space, then the
details are truncated, but the full information can be accessed by
resting the mouse cursor over the appropriate region for a few
seconds to reveal a 'tool tip' containing the full details.

On the far right hand side are the window controls:

Close - closes the window and returns to the database display. If any
matching has been done, and results from it have not been saved,
then the program will check if the user wishes to save them to a file.

Save Results - once a matching calculation has taken place, this
option allows the tabled results to be exported to a either an ASCII
text or Microsoft Excel compatible file. Enter the filename and select
the filetype from the list in the standard File Save dialog box. This
option is also available from the File menu. (N.B. only the results
from the most recent matching run will be saved by this method,
hence separate saves would be required to keep results from multiple
runs.)

Print - brings up a standard Windows Print dialog, and causes the
current contents of the graph pane to be sent to your selected printer.
This option is also available under the Graph menu.

Note that printing to a postscript printer may be very slow as every
single datapoint (usually several thousand) is sent to the printer.
Much faster results can be obtained with a non-postscript printer, for
example an inkjet.

The remaining controls in the window are the mode-dependant
controls.

The user can switch between the two matching modes by means of
the tabs in the top left of the window:
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3.4.6  Pattern Matching

The first tab represents the Pattern matching program mode: 

This process involves the repeated comparison of pairs of datasets,
the sample and the database patterns.

The sample pattern is the pattern that is being compared to the rest of
the patterns in the database. For each pattern, a comparison is made
as follows:

1. The full profiles of the patterns are compared on a point by point
basis using the non-parametric Spearman rank-order coefficient test.
The result from this appears in the results column headed
‘Spearman’. A score of 1.0 represents a perfect match, 0.0 the worst
possible match, and -1.0 a negative correlation (see Section 3.6,
References).

2. A parametric Pearson equivalent of the Spearman test is then
applied, both to the full intersecting profile (results shown in column
Parametric), and to individual corresponding peaks (results shown in
column Para Peaks). 

3. If any peaks have been marked in the sample and database
patterns, the probability of correlation between the two is also
calculated using the Kolmogorov-Smirnov test (see Section 3.6,
References).

4. The range of each peak to be tested is taken to be the intersection
of the two peaks ranges, calculated by tracing their shoulders until
either the intensity falls below a set threshold, or the intensity starts
to increase again. 

5. The pattern with the greater number of peaks is taken as a
reference, (its number of peaks = m).

The Kolmogorov-Smirnov test is then performed on each of these
peaks, and a probability value p returned for each one. This is 1.0
where peaks are identical and zero when a peak is matched against no
peak.

Then K-S value for the overall pattern is: 
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(p1+p2+p3+…+pm)/m

which returns a value between 0 and 1.0. Note that the test results for
each individual peak can also be examined in the Single Peak Viewer
- see Section 3.4.8.6, Match Peak.

6. Results are reported in the Kol-Smir column, where a result of 1.0
corresponds to a perfect match. This is also true of the Para Peaks
result, which is calculated in a similar manner.

7. Finally, a Rank value is calculated for each database sample after
comparison, comprised of a weighted mean of each of the available
statistics. These weights are user-definable - see Section 3.4.8.2,
Rank Weightings.

3.4.7  Non-quantitative Peak Matching:

Click the Match button (or press F1). Matching will commence.
Progress is indicated by the progress bar and status bar:

Once matching has completed, the results will be displayed in the
results pane:

The best overall match is shown at the top of the list, which is sorted
by default in descending order of Rank. The best match is always the
pattern you are matching against. This provides a useful check that
everything is operating correctly, since the unknown pattern matched
against itself should give a perfect match in all four tests.

i.e. it should have a 
                              Spearman of 1.0 
                              Parametric of 1.0
                              Kol-Smir of 1.0
                              Para Peaks of 1.0

and a rank (calculated from 0.5×Spearman + 0.5×Parametric) of 1.0
(assuming default weightings).
97



98
To view a pattern overlayed on the matched pattern, click once in the
leftmost column of that pattern (the third row in the example below):

Clicking once in this column for a particular pattern results in a
coloured dot appearing, and the corresponding pattern being shown
in the graph pane, superimposed upon the matched pattern using the
colour of the spot. 

Clicking the same column again removes the pattern from the graph
pane. Up to seven different patterns can be displayed at once in this
manner. To remove multiple displayed graphs in one step, a Remove
Overlaid Graphs option is available from the Graph menu, or the
pop-up menu obtained by right-clicking on the graph region.

The sort-order in which the results are displayed can be changed by
clicking the header of the column on which you wish the results
sorted. Clicking the same header again causes the results to be sorted
in that same column, but in the opposite order i.e. repeatedly clicking
on one header causes the sort order to switch between ascending and
descending.

If the top few patterns appear to be a really bad match, the chances
are that the list has been sorted in descending order. Click again to re-
sort.



Pattern Matching and Analysis
3.4.8  Advanced Options

3.4.8.1  Refine linear/non-linear offset

Selecting the Refine linear/non-linear offset checkbox causes an 2θ-
axis offset to be computed when comparing patterns.

For example, if two patterns are very similar, except that one is offset
by +0.3 degrees along the 2θ-axis from the other, selecting this
option should reveal this.

The maximum amount by which patterns are allowed to be offset can
be changed from the default of 0.4 degrees by changing the values in
the Advanced pane of the program Options dialog box. The program
attempts to maximise the correlation between patterns by varying the
values a0 and a1 in the equation ∆2θ = a0 + a1 sin θ, although cos θ or
sin 2θ may optionally be used instead.

After turning the option on, click Match to begin the matching. This
process will be much slower than the default matching, as many
more calculations are being performed for each pattern.

Once complete, the results are displayed as before, with one
difference. There is now an additional column on the far right - Offset
used: 

This corresponds to the amount of offset (a0, a1) required to
maximise the correlation coefficients for each pattern.

As a shift of up to about one degree can be possible when dealing
with patterns of the same substance recorded with different
experimental conditions, and this option may be useful to reveal
matches between patterns that at first appear to be different.
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Note that at present the shift only applies to the profile based tests
and that this option can slow down the operation of the program
substantially. 

3.4.8.2  Rank Weightings

For patterns of a particular type, it may be the case that one particular
correlation coefficient proves to be more useful than others. 

In order to relate this fact to the overall ranking of pattern matches, it
is possible to change the way the overall rank is calculated. 

Normally, this is of the form:

Rank = w1×(Parametric score) + w2×(Spearman score)

+w3×(Kol-Smir score) + w4×(Para Pks score)

where w1 and w2 are the rank weightings, normally both 1.0. By
varying these weightings.

It is possible to alter the overall rank order of the matched patterns,
for example:

Once the weighting have been altered, the Apply button is activated.
Clicking it applies the new rank weightings to the current list of
matched results:

If rank weightings are changed from the default values before a
match has taken place, the new values are used automatically when
the results are displayed.
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3.4.8.3  Limit x-axis range...

Turning on the Limit x-axis range checkbox has the effect of limiting
the analysis calculation to a subset of the entire x-axis range of the
unknown pattern. This can be useful if a particular feature of the
pattern is causing problems for the calculation.

The default values in the textboxes are the full range of the unknown
pattern, although these can be changed by either:

1. Typing in the desired start and end angles of the required range
into the textboxes, or:

2. Zooming in to the desired range by clicking and dragging a zoom-
rectangle on the graph pane. The start and end ranges of the 2θ-range
of the zoomed region of the pattern will be automatically placed in
the textboxes.

To use this feature, turn the checkbox on, enter the desired start- and
end- details, and click the Calculate button.

3.4.8.4  Difference Plots

When comparing two very similar patterns it can be useful to get a
different kind of visual feedback as to their similarity. One such
feedback method is the difference plot, which subtracts the selected
database pattern from the unknown pattern and displays the
remainder. This feature is accessed by first clicking once to select a
database pattern from the list of match results, and then either
selecting Show Difference Plot from the Pattern menu, or clicking
once with the right-hand mouse button to access the results pane pop-
up menu:
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Selecting the Show Difference Plot option brings up the following
window:

The Print button outputs the graph pane to the local Windows printer.

The Close button returns to the main Match window. 

The Export button saves the difference profile to an ASCII text file.

3.4.8.5  Match All

This option is only available for a maximum of 1000 patterns in a
database. It matches every pattern in the database against every other
pattern in one step, and displays a matrix of results. 

Please note that with this large number of patterns the matching
process will take some time to complete, and this will be exacerbated
if the allow x-offset option is enabled.

Clicking the Match All button produces a dialog in which to select
the individual tests to be used:



Pattern Matching and Analysis
Select the tests of choice, their required weightings and enter the
highlight cut-off value (any results greater than this value will be
highlighted in the results table).

Clicking OK initiates the matching process. This may take some
time, as n2/2-n matching tests are being performed (where n is the
number of patterns in the database). When over 50 patterns are being
matched, a window with a progress bar is displayed. When complete,
the results are displayed as follows:

The results pane is automatically vertically enlarged to show more of
the results. To toggle between this enlarged size, and the standard
size, click on the grey region between the results table and the graph
pane.

Any test scores that are above the cut-off level selected in the
preceding dialog box are highlighted in bold. This procedure may
reveal hitherto unnoticed correlations between different patterns in a
database.

All the matching results obtained against upd3-004 are shown in the
first column, upd3-005 in the second, and so on. By looking at the
intersections between patterns, an idea of the similarities between
any two database patterns may be obtained.

To view a particular correlation of interest graphically, click once on
the grid square containing the result. For example, the patterns upd3-
005 and upd3-008 have a match score of 0.9251 in the above result.
Clicking on the square containing the 0.9251 results in the two
patterns of interest being superimposed on the graph pane below to
allow visual comparison.

If the option to refine pattern shifts was selected, after clicking on a
given correlation, holding the mouse steady for a second brings up a
tooltip containing the calculated best offset for the two patterns, in
the form (a0, a1) as discussed above.
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3.4.8.6  Match Peak

Individual corresponding peaks can be easily compared in this mode.
This can be particularly useful to spot very small differences between
otherwise almost identical patterns: click once in the results list to
select the pattern you wish to compare the unknown pattern with.

Then click the Match Peak... button (or select Show Peak
Comparison from the Pattern menu). The window will appear for the
first of the matched peaks:

Clicking Next Peak closes this window and opens another for the
next peak common to both patterns. Cancel returns to the match
window.

Detailed results of the Kol-Smir and Parametric Peaks test results are
shown on an individual peak basis in this window (these individual
values are combined to give the result for the whole pattern displayed
in the main match window results pane).

3.5  Quantitative Analysis

The second tab represents the second of the main program modes:
Quantitative Analysis:

This is used with patterns of mixtures to estimate their percentage
composition from pure component patterns contained in the
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matching database. Note that for the method to work successfully,
patterns corresponding to all pure phases in the mixture must be
present in the current working database.

3.5.1  Standard Quantitative Analysis:

Click the Calculate button (or press F3). Analysis of the selected
unknown pattern will commence. Prior to analysing, a pattern
matching calculation is performed.

The progress and status bars indicate this:

Before showing that analysis is taking place:

Note that this process may take some time, depending on the number
of patterns included in the calculation. The progress bar is not
updated during the calculation of relative proportions, so patience is
required as the calculations are very processor intensive, and may
take several minutes. The screen is not updated or redrawn while this
is happening.

Once analysis has completed, the results will be displayed in the
results pane:

Note that the headers have changed. Although the first 6 columns are
the same as before, there are 3 new columns:

1. Offset used:

The offset given to a particular pattern that gave the best match;
see section 4.4.2.1

2. Scale % or Weight %: 

Displays what proportion of the mixture is accounted for by an
individual database pattern. This is normally displayed as a scale
percentage i.e. what percentage of the mixture pattern does each
individual phase constitute?
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If all the required advanced pattern information has been entered
(see Section 3.3.11, Additional Pattern Information), the program
converts this scale percentage to an actual percentage of the mix-
ture by weight. In this case, the column heading is changed to
Weight %. 
Note that this information must have been entered for ALL phases
in the mixture to be able to calculate a weight fraction.

3. Std Dev.

The standard deviation of the percentage composition calculation
reported for each pattern.

By default, the maximum number of patterns that will be reported as
included in a mixture is 6, although this is easily changed. (see
section 4.6, Matching Options)

As before, patterns can be displayed over the unknown pattern by
clicking once in the leftmost column:

This can provide valuable visual feedback for the user to check if the
suggested constituents of the unknown mixture are indeed correct.

To view a phase pattern on top of the mixture pattern scaled to the
percentage result suggested, check the Scale Graphs checkbox, and
then click on the pattern to display it in the usual way. If the Scale
Graphs option is checked, and the Show Difference Graph option is
selected, the individual phase pattern will be subtracted from the
mixture pattern scaled to the relevant %. The amount of scaling
performed is shown in the difference graph window:
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Additional feedback on the results is given by the calculated error on
the suggested percentage, and by how good the matching results of
the Spearman, Parametric and Kol-Smir tests were for each phase.

Occasionally if an incorrect pattern has been suggested by the
program, this may be shown by extremely low values of the
Spearman, Parametric and Kol-Smir tests, and such patterns can be
marked to be ignored during subsequent runs - see 3.5.2.2, Exclude
patterns...).

3.5.1.1  Automatic Missing Phase Detection

The program examines the results from the analysis, and based on the
calculated error and residual trace can suggest if the result does not
account sufficiently for all of the unknown pattern intensity:

This would occur in a case where not all of the phases present in a
mixture pattern were in the database being used.

Selecting Yes in the above dialog causes the program to simulate a
pattern corresponding to the intensity unaccounted for by the current
results. (This simulated pattern is equivalent to the pattern obtained
by saving the positive intensity trace from the Residual window; see
Section 3.5.2.6, Residual Window for more details.)

The calculation is then re-run to include this simulated missing
phase, and results re-calculated:

Note that results cannot be calculated in terms of weight fraction
when simulated missing phases are included.

After doing an analysis, and choosing to include a missing phase,
when the user closes the match window, the program checks to see if
the simulated phase should be retained in the current database or
discarded.

If the pattern is retained, it shows up in the database window with a
name of  'Simulated Missing Phase', although this can of course be
altered in the Edit window later.
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The settings used by the program to determine if a missing phase
may be present can be controlled by the user; see section 4.3.10 on
page 118.

3.5.2  Advanced Analysis

3.5.2.1  Refine linear/non-linear shift

This option works as described in Section 3.4.8.1, Refine linear/non-
linear offset.

3.5.2.2  Exclude patterns...

Selecting the Exclude Patterns checkbox can be extremely useful to
narrow down the number of patterns to be considered as components
of the unknown pattern. It does this by excluding patterns that are
below user-set thresholds on any of the matching tests to be included
in the quantitative calculation. 

The default values may be easily altered by changing the relevant
values in the text boxes. The best values to use can change depending
on the type of data being considered. 

Generally, the best approach is to perform a standard analysis with
defaults to begin with, and see if any poorly matching patterns have
been included. The results from this will then give a feel for what
values the cut-offs should be set at. This option also has the side
benefit of speeding up the process as less patterns are used.

To use this option, turn on the checkbox, enter the desired values, and
click the Calculate button as normal.

3.5.2.3  Limit x-axis range...

Turning on the Limit x-axis range checkbox has the effect of limiting
the analysis calculation to a subset of the entire x-axis range of the
unknown pattern. This can be useful if a particular feature of the
pattern is causing problems for the calculation.

The default values in the textboxes are the full range of the unknown
pattern, although these can be changed by either:

1. Typing in the desired start and end angles of the required range
into the textboxes, or:
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2. Zooming in to the desired range by clicking and dragging a zoom-
rectangle on the graph pane. The start and end ranges of the x-range
of the zoomed pattern will automatically be placed in the textboxes.

To use this feature, turn the checkbox on, enter the desired start- and
end- details, and click the Calculate button.

3.5.2.4  Ignore selected pattern

If a particular pattern included in the list of suggested results is
known to be incorrect, it can be excluded from the calculation, by
clicking once on it in the results pane to select it, and then by either
right-clicking to bring up the results-pane pop-up menu, using the
Mark/Unmark Pattern as Ignored option in the Pattern menu.

Select Mark/Unmark this Pattern as Ignored. A large, bold X will
appear next to the pattern name in the first column, to indicate it is
being ignored for the purposes of the calculation.

Once a pattern has been selected as ignored, click the Calculate
button again to re-run the calculation, which will be performed
without any the ‘Ignored’ patterns.

If the pattern was incorrectly marked as ignored, it may be unmarked,
by simply repeating the above procedure, and selecting Mark/
Unmark this Pattern as Ignored once more. The large X will
disappear.

It is possible to mark multiple patterns to be ignored by repeating this
process with different selected patterns.
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3.5.2.5  Ignore All patterns except.

In situations where the particular constituent patterns of an unknown
mixture are known, but only the relative percentages of each are
unknown, it is useful to be able to only include the correct
components in the calculation. This not only speeds up the process
but can generally improve the accuracy of the results.

The simplest way to achieve this is to first mark all of the patterns in
the database to be ignored, and then un-mark the individual patterns
that are known to be present in the mixture.

To achieve this, right-click on the results pane to bring up the pop-up
menu, or use the Pattern menu: select Mark/Unmark all Patterns as
Ignored from the options presented. A black bold X will appear in
the first column of the results pane next to every pattern shown. (N.B.
if any patterns have previously been marked as ignored, these will be
un-marked by this process).

Next, individually unmark the patterns that are to be included by
selecting them singly, and selecting Mark/Unmark this Pattern as
Ignored from the pop-up menu. Then select Calculate as normal.

To unmark all of the marked patterns simultaneously, select Mark/
Unmark all Patterns as Ignored again from the pop-up menu. All
patterns that were marked as ignored will become unmarked, and
vice-versa.

N.B. If the patterns that have been marked and unmarked become
confused, it is possible to reset all of the patterns in the database to
the default state of all being included in a calculation, by closing the
match window and then re-opening it.

3.5.2.6  Residual Window

To see if the suggested results are correct, or if they include a pattern
not present in the mixture, or if they miss out a pattern that should be
there, the residual window constructs a calculated pattern made up
from the various individual patterns suggested as mixture
components, in the proportions calculated.
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Clicking the Residual button brings up the following window:

The upper window overlays the original mixture pattern (in blue)
with the calculated one using the suggested results (in red/brown).

The difference between the two profiles is shown in the bottom
window. Large negative peaks in this correspond to incorrect peaks,
and would suggest one or more of the suggested constituent phases
are incorrect. Positive peaks here would represent peaks in the
original pattern not accounted for in the suggested results.

The simulated mixture pattern can be saved to an ASCII text file
using the Export Simulated button. The difference plot can be saved
to an ASCII file using the Export Difference button.

In the latter option, two different formats are available from the pop-
up list at the bottom of the Windows Save dialog. The first (Full
residual) saves the difference profile as it is shown in the window,
with some peaks negative and some positive. The second (Positive
residual) ignores any negative peaks and saves only positive ones in
order to make a pattern comprising only intensity not accounted for
by the current pure phases.
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Exported difference profiles can be re-imported and treated as new
patterns, and further quantitative analysis can be performed using
them if required. This can be done manually or by using the Add to
Database option. 

3.5.3  Other Options

Edit this pattern

Having performed a match or analysis procedure, it may be that one
pattern listed in the results table is of particular interest. It is possible
to view the Pattern Editor window for such a pattern directly, by first
clicking once on the pattern of interest in the list, and either selecting
Edit from the Pattern menu, or Edit this Pattern from the pop-up
menu.

Either option brings up the editor dialog allowing detailed
information about a pattern to be viewed or edited.

Match against this pattern

Having performed a match or analysis procedure, it may be that one
pattern listed in the results table is of particular interest, and the user
my wish to perform an additional match or analysis with that pattern.

It is possible to open another Match window for such a pattern
directly, by first clicking once on the pattern of interest in the list, and
either selecting Match from the Pattern menu, or Match against this
Pattern from the pop-up menu.

Either option brings up a new Match window. The original Match
window is still open and may be viewed as desired. As many Match
windows as required may be open at the same time.
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CHAPTER 4 Program Options and Defaults
4.1  Accessing Options

The options menu can be accessed at any point from the Edit menu.

The Options window is comprised of three tab sections which can be
selected from the top of the window.

These are each described in turn below.

Note that that ‘Manual’ settings do not affect Automatic Analysis
runs and vice versa.
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4.2  Manual Analysis: General Options

When the Options window first opens it displays the Manual
Analysis section first by default.

This first tab is split a general section and a processing section.

4.2.1  General Section

Double-clicking Database Lists

The first option controls whether double-clicking a pattern entry in
an open database window brings up the match window or the pattern
editor window. By default this is set to being the Pattern Editor.

Graph Drawing

Decides whether the patterns are displayed in a high-quality, but slow
to draw mode, or a faster but lesser quality mode. The slower option
is the default.

Use Bold Grid Lines checkbox controls if a black grid shown behind
patterns on the graph, or if light-grey lines are used. The latter is the
default.

The two Data Display checkboxes control whether the patterns are
displayed as read in from their original data files, or flipped in either
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the x or y axes. These options may be useful when examining
different types of non-powder diffraction x-y data.

4.2.1.1  Results Display

This section contains a toggle to switch between displaying the
Chemical name/ID or the Filename of patterns in the Match window
and other results lists.

5.1.1.3 Processing Options

The next section controls which of the three main processing options
are turned on by default in the window which appears when patterns
are being imported. A default wavelength can be selected - either one
of the standard ones from the pop-up list, or a custom value entered
into the text box. The default value is CuKα.

5.1.1.4 Smoothing Factor

Varying the number in this box controls the amount of noise removal
performed by the wavelet smoothing. The larger the number, the
smoother the resulting pattern. Be careful of oversmoothing and
losing valuable information. 1 is a good default value in most cases.

5.1.1.5 Default Peak Threshold

The next control changes the default peak threshold. Only peaks
whose maximum intensity are above this cut-off value will be
marked as such. The default value of 0.05 can be changed by
dragging the slider left or right. The corresponding numerical value
for the threshold is shown to the right of the slider.

4.2.1.2  Default Pattern Database Location

The final region lets the default database be located and selected.
This is the database that is opened when the Open Default option is
selected from the File menu.

To change, click the Change... button. A Windows file selection
dialog box will appear. Locate and select the database required, and
click Open.

The file and location selected should be displayed in the window. In
the example shown above, the default is processed.par which is
located at C:\.
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4.3  Manual Analysis: Advanced Options

The second tab, Advanced, contains the more in depth matching and
quantitative analysis controls.

4.3.1  Default Match Options

This section controls the default values for the Rank Weightings in 
the Match Window.

The default values are: Spearman 0.5, Parametric 0.5, Kol-Smir 0.0, 
Para Pks 0.0. 

4.3.2  Default Match All Options

This section controls which matching tests and what corresponding
weightings come up by default in the Match All settings window.
Initial values are to use the Spearman and Parametric tests, each with
a weighting of 0.5.

Note that it is recommended that the sum of any weights used is 1.0.

4.3.3  Optimise x-shifts

This section controls how patterns will be shifted in an attempt to
maximise the correlations between them. By default the program
attempts to maximise the correlation between patterns by varying the
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values a0 and a1 in the equation ∆2θ = a0 + a1 sin θ, although cos θ or
sin 2θ may optionally be used instead by selecting the relevant item
from the drop-down menu.

The values of a0 and a1 that may be entered here represent the
maximum values that will be allowed by the program during the
refinement.

4.3.4  Report a maximum of n components

The maximum number of patterns that PolySNAP M suggests as
being constituents of an unknown mixture can be easily changed by
the user. By default, it reports a maximum of 6 components. This
default can be changed to any integer between 1 and 15. Note that
this must be done before a match window is opened in order for any
changes to take effect.

4.3.5  Matrix tolerance

The second controls what proportion of the patterns that do not
contribute significantly to the overall pattern are ignored. This should
be a number between 1 and 0. The default is 1x10-5. 

4.3.6  No. of refinement loops

The Refinement loops field controls how many loops of refinement
the program performs. This should be an integer between 1 and 3. If
it is 1, all patterns are included. If it is 2, all patterns are used, then
only the top 15 are included the second time around. If it is 3, then all
patterns, then the top 15, then the top N, where N is the number of
components selected above, are included.

4.3.7  Ignore pattern below...

This (default is 0.001) controls how much of each database pattern is
treated as background upon inclusion in the calculation. This is done
to simplify the problem and reduce the effect of background noise.

4.3.8  Hide zero % components in results

With a database containing a large number of patterns, performing an
analysis usually results in a few patterns contributing towards a
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mixture, with the rest being ranked at 0.0%. This option hides any
patterns that are not considered contributors to the mixture.

4.3.9  Calculate Weight Fractions if possible

This checkbox allows the program to automatically display analysis
results as a weight fraction rather than proportional to scattering
power, if all the necessary pattern information is available.

With it turned off, a scale percent is reported even if all pattern
information is present. (See section 3.3.11 on page 87 for
information on what details are required to calculate a weight
fraction).

4.3.10  Suspect Missing Phases...

These controls set the values beyond which the program considers
that missing phases may be present in a mixture (see section 3.5.1.1
on page 107 for more information). 

The two criteria used are the size of the largest calculated error on the
quantitative results, and if the residual intensity trace has any peaks
above the default minimum peak height.

In addition, if the Automatically Recalculate for Missing
Phases option is checked, the program will recalculate to include
missing phases automatically, without consulting the user first. The
default value for this is to consult the user.
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4.4  Automatic Analysis: General Options

4.4.1  Default File Locations

4.4.1.1  Default Directories 

If no working input directory has been specified via a command-line 
argument or other input method, the program uses the directories 
specified here as its default. To alter any of them, click on the Browse 
button to bring up a directory selection window: 
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Selection of a new working directory is carried out by first selecting
the correct drive letter from the pop-up menu at the top, and then
navigating to the desired folder via the lower navigation box. To open
a folder to see what other sub-directories it contains, double-click on
it. When the desired folder has been located, double click on it to
ensure it is selected, and click OK. 

Ensure these settings are correct, as problems here may prevent the
program from running correctly in automatic mode. Note that setting
the input and output directories to the same location is not permitted,
and will generate an error.

4.4.2  Other settings

4.4.2.1  Warn before deleting any output files

With this option selected, the user is always warned when selecting
an output folder that already contains files from a previous program
run. The older files will be deleted if the user continues. If the related
option, Allow logfile to be deleted, is off then logfiles and errorlogs
are merely appended to on subsequent runs, rather than started
afresh.

4.4.2.2  Show graphics toolbars when available

In the results display window, several of the graphics panes have
toolbars to allow quick access to commonly used functions. This
option sets if they are displayed by default or not.

4.4.2.3  Cell/Stack display: Show [ ] pies per row

For a display puposes the number of pies in a row can be altered to
suit the users needs. e.g. for a run of 12 samples the number entered
may be 6, which would create 2 rows of 6. The minimum value is 2
and the maximum value is 199. If the value is set to -1, the program
makes its own judgement as to the best number to display for a given
run to fit in the display window, and this behaviour is the default.

4.4.2.4  Extract label from filename in the pattern in the form

With this option on, sample ID information contained be parsed and
used to identify the pattern on the Cell Display and Dendrogram
Display. With the first option, Label.pat, the entire unique part of the
filename is used (though only the final 7 characters are displayed; the
full label can be seen in a tooltip by hovering the mouse over a
sample). With the second option, xxx_Label.pat, only that portion of
the filename after the final underscore character is used as a sample
label. The third option, xxx_Label1_Label2.pat uses the information
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after the final two underscores as the label, and ignores any previous
part of the filename. 

4.4.2.5  Minimum Peak Intensity Threshold

This control changes the default peak threshold. Only peaks whose
maximum intensity are above this cut-off value will be marked as
peaks, and therefore included for comparison in the peak-based tests.
The number of peaks marked can also be used as an indicator of
crystallinity of a sample. The default value is 0.05; the acceptable
range is from 0 to 1.0.

4.4.2.6  Smooth Data and Smoothing Factor

Varying the number in this box controls the amount of noise removal
performed by the wavelet smoothing routines. The larger the number,
the smoother the resulting pattern. Be careful of oversmoothing and
either losing valuable information, or introducing artifacts into the
signal. The default value is 1.

4.4.2.7  Powder Data: Background Subtraction

Selecting the first checkbox performs the standard powder
background subtraction as used in Manual Analysis. The second
checkbox, Strict subtraction, applies an additional pass that is
intended for use when there is a large amorphous contribution to the
patterns that is required to be removed. It should be used with caution
as the possibility of removing more pattern than is required is more
likely.

4.4.2.8  Quantitative Options

Clicking on the Quantitative button opens the Quantitative Options 
window.

Run quantitative analysis on patterns that are not similar to any
known phases provided - This option can be activated or deactivated
by clicking on the check box, and controls whether or not the
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program performs quantitative analysis on samples it considers to be
possible mixtures. 

It is possible to limit the maximum number of phases the program
will suggest as possible components in a mixture with the option:

Limit number of possible phases in a mixture to [ ]

This can have any integer value between 1 and 15. The default value
is 6; if the initial number of results returned is greater than the value
set here, only the top x results are reported (where x is the value
entered here). The results which are reported can be further filtered
by means of the following two options:

Ignore any results below [ ] percent - can have any value between 0
and 100. The default value is 5%. This sets the smallest percentage
value which will be returned as significant; anything below this
cutoff level will be ignored.

or where the error on the largest result is greater than [ ] percent -
can have any value between 0 and 1000. The default value is 100.
This sets the level for the error value calculated for each phase. If the
error on a particular phase exceeds the amount entered here, it is not
considered as a possible phase in the mixture pattern. 

4.5  Reset All

There is a Reset All... button located at the bottom of the options 
window. Clicking this button resets all of the program options to their 
default settings. This option cannot be undone.



CHAPTER 5 PolySNAP M Tutorial
5.1  Introduction

This tutorial has been designed to guide the user through a few
examples using PolySNAP M with typical data that might be
encountered in general use. It is not intended as a replacement for the
full program manual, but as a basic introduction to actually using the
program. It should therefore be read in conjunction with the manual
itself for a more detailed explanation where necessary.

The tutorial requires the user to have already installed PolySNAP M,
and be familiar with Windows-based interfaces. The data files used in
the tutorial are installed along with the software, and can usually be
found in the  tutorial  folder in C:\Program Files\PolySNAP M.

5.1.1  Simple Automatic Pattern Matching

To gain experience with PolySNAP M, a simple run using 21 X-ray
powder diffraction patterns is performed. The example assumes the
program defaults are used, and any more advanced options are
unnecessary.

To begin, launch the PolySNAP M program from either the icon on
Windows desktop or via the shortcut in the Windows Start menu.

5.1.2  Selecting Input and Output Folders

Once PolySNAP M has been launched the user is presented with an
empty window that contains only a menu bar. From this, the first step
is to define the input folder containing the necessary patterns and the
output folder where the results are to be placed.
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From the File menu, select Automatic Analysis and the Run on...
option. The following dialog box should appear.

1. To define the input folder containing the sample data files, click 
the Folder button in the top section of the dialog box. A folder-
selection dialog box will appear.

2. Select the drive containing the tutorial data from the pop-up
menu at the top. In this case, select D:.

3. Navigate to the folder C:\Program Files\PolySNAP M\tuto-
rial\simple_txt\. Ensure that the last folder of the desired path (i.e.
simple_txt) is selected by double clicking it (the folder icon
should appear 'open').

4. Click OK. The selected path should be displayed in the upper
portion of the dialog box. Check it is correct; if it is not, repeat
the previous step.

5. In the Run PolySNAP M on... dialog box again, ensure that the
central section of the dialog box has no defined folder, indicated
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by the word '<None>'. If this is not the case, uncheck the check-
box labelled Use Folder containing Known/Reference data files.
The use of this setting will be explained later.

6. The output folder where the result files are to be placed must be
defined. Click the third Folder button in the next section of the
dialog box. A folder selection dialog box will appear as before.

7. Select the local hard disk on your machine, which in this case is
C:. (Alternatively any other drive you wish to use for the output
data may be selected.)

8. Navigate to the folder you wish to place the output files. e.g.
C:\output\. If required use the New Folder button to create a new
folder. Ensure that the last folder of the path is selected by double
clicking it (the folder icon should appear 'open'). Note that you
cannot use the same directory for both input and output.

9. Click OK, and check that the desired path is displayed correctly.
10. Leave the Advanced Options settings to their default values (all

should be off except for Check for amorphous samples).
11. Finally, in the Run PolySNAP M on... dialog box click OK.

The pattern files from the specified input folder will now be loaded
into PolySNAP M.

5.1.3   Pattern Matching the Different Powder Patterns

PolySNAP M is now in automatic mode, and proceeds by reading the
sample files from the specified input folder, and loading these into a
database located in the output folder.

Each pattern is loaded in turn, with the first pattern profile shown on
the top right and the most recently loaded profile below it. When all
21 patterns have been loaded the process will stop. 
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The program now examines the input files, checking for amorphous
samples, matches the data files against one another, and then
performs cluster analysis. When complete the results window will
appear.

5.1.4  Viewing the Results in the Cell Display

There are now a number of ways to view and examine the PolySNAP
M results. The first of these, and default view displayed is the Cell
Display, which visually represents the contents of each sample cell.

Each cell (shown as a disc) represents a different pattern from the
input folder, with colour being used to denote the suggested grouping
of compounds. In other words, similar samples are given the same
colour. In the lower part of the window the sample information and
pattern display of the selected cell is available. The first sample cell
is selected automatically when the window is first opened.

1. In the Cell Display click on cell FORMD1. The associated full
pattern profile of pattern D1 is now displayed in the lower region
of the window beside the sample information. In this particular
case the information available is limited, so many of the fields are
blank.

2. Hold down the shift key and click on cell FORMD4. The cells
from D1 to D4 are now selected, and the sample information
pane now disappears, leaving only an extended view of the pro-
files of patterns D1, D3 and D4 overlaid to allow a visual com-
parison. From this view they are all obviously the same
compound.

3. From the Display menu select Offset Overlaid Pattern Profiles
and click on y-axis. This will now display the multiple patterns
with an offset along the y-axis of the plot, when any further cells
are selected.
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4. Hold down the control key and click on cell MIXT_2. The display
now includes this new fourth pattern, and to allow an easy com-
parison are displayed overlaid with an offset along the y-axis.

5. Zoom into the area between around 15° and 20° by holding down
the left mouse button and dragging a box over the desired area.
When the mouse button is released, the graph region is redrawn
to show just the selected area. Zooming in and out smoothly can
also be accomplished by clicking in the display and then holding
down the control key while moving the scroll wheel of the mouse
(if available).

6. To move around the area and position the view more accurately,
hold down the Alt key and left mouse button simultaneously
while dragging with the mouse - the display updates in real time.

These zoom and movement functions are the same for all graphical
displays within the PolySNAP M program.

To check which of the plotted profiles correspond to which sample,
'hover' the mouse over part of the plotted line; a tooltip appears with
the sample filename in it.

This closer view of the overlaid patterns makes it easier to see that
the top pattern (MIXT_2) is noticeably different from the other
patterns - note the extra peak around 14° for example - and may not
actually belong to this group of compounds.

7. Reset the view with a right click of the mouse in the graph pane
and selecting Reset View from the pop-up menu.

5.1.5  Viewing the Results by Dendrogram

In the PolySNAP M window there are a series of tabs just below the
menu bar, each of which display a different view of the data. Select
the tab labelled Dendrogram.
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The partitioning of the data into groups that were displayed in the
coloured cells is carried out by the cluster analysis of the sample
data. In PolySNAP M there are five different methods of clustering
available, each of which tend to give slightly different results. The
program computes the best, in the sense of the most internally
consistent, dendrogram method and displays the results from that
(although the user can choose to view the results from the other
methods and overrule the selected one if required).

A dendrogram provides a visual display of the results from the
hierarchical method of data classification using cluster analysis. The
dendrogram itself takes the form of a tree-diagram in which each
terminal branch (coloured box) is representative of a single pattern
sample.

The higher up the similarity scale two samples are connected by a
horizontal line, the less similar they are. Hence samples FORMA1
and A3, with a similarity value of around 0.9 are very similar,
whereas samples FORMA1 and FORMC1, which are only joined
much further up the tree by a horizontal line with a similarity value of
around 0.4, are quite different.

In this dendrogram there are 6 separate clusters, each distinguished
by its own colour. These are the same colours displayed earlier in the
cell display and throughout most of the other PolySNAP M displays.
The number of clusters are defined by the yellow cut-line which in
this case was initially set to 0.744. The calculation of this level is via
a number of statistics. The confidence levels on this choice of cut
position are shown by the yellow dotted lines either side. Selecting a
cut-line for a dendrogram is a difficult procedure, and the results
must be treated with caution. The program-calculated level therefore
should always be carefully examined by the user to see if looks
sensible.
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Adjusting the cut level upwards creates fewer separate clusters, and
effectively reduces the discrimination between differences; adjusting
the cut-level downwards creates more separate clusters.

1. In the dendrogram click on the yellow square cell FORMD1. The 
pattern profile of the sample is displayed.

2. Using the control key, also select cell MIXT_2. These are the two 
patterns that appeared different from one another when they were 
overlaid in the cell display. 

Looking at the position of the cut-line it is seen to be only very
slightly above the similarity line between cell MIXT_2 and the other
yellow cells. It can also be seen that another group (the dark blue and
light blue samples) has only just been split by it. With the confidence
levels indicated by the yellow lines being between 4 and 7 clusters, it
is possible that the present level is not ideal.

3. To manually adjust the cut-line, either click in the Dendrogram 
area and use the scroll wheel or hold down control and the left 
mouse button while dragging up or down. Move the cut-line 
down slightly so that it is still above the lower confidence line but 
so there are now 7 different clusters. Notice that the assigned 
colours change, and that cell 20 is now in a cluster of its own.

4. In the dendrogram area click the right mouse button and select 
Save Modified Trees...., to ensure that the changes are retained.
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5. From the Tools menu select List Pattern Cluster Members.... A 
dialog box will appear containing a list of the clusters.

This dialog box displays the different clusters with their sample
numbers and actual file names. From the file names used in this
demonstration example it can be seen that the samples are now all
properly grouped, with the two mixtures separate from the rest.
Notice in the dendrogram display that these two mixture patterns are
quite dissimilar to anything else, having a low similarity connection
value to their neighbours.

5.1.6  Viewing the Results by 3-D Plot

The samples can also be viewed by making use of the distances
between objects derived from the correlation matrix to give a
representation of the data in three dimensions. There are two
methods used for calculating the resulting 3-D plots: these are Metric
Multi-Dimensional Scaling (MMDS) and Principle Component
Analysis (PCA). They both give different views of the samples
because of the differences in calculation and will therefore give
slightly different results. The control of each plot is the same so only
the MMDS will be described here in detail.
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Select the tab 3D Plot (MMDS) (or PCA if you wish).

The initial view shows only the x and y axis, while the z axis lies in
projection. Each point represents a sample. The position on the plot is
taken from the MMDS calculation. The colour of each sample is
taken from the dendrogram display to allow easy comparison of the
results from these different methods. Allowing the mouse to hover
over a sample displays the sample label in a tooltip popup.

Samples that are similar are plotted close to one another, so are seen
to clump together in groups. Note that different coloured samples can
also be close, this shows that they also have similarities. This can be
seen by the yellow group being very close to the green sample, which
is pattern MIXT_2 and, when comparing to the dendrogram display,
is only separated from the yellow group by the current level of the
cut-line.

Also notice the number plotted at the top-left of the display, in this
case, 0.96. This is a correlation coefficient measuring the quality of
the 3D representation to the original data. The closer to 1.0 it is, the
greater the reliability of the results. This value tends to decrease
when larger data sets are used.

Use the following methods for exploring the 3-D plot.

Action Control
Rotate the 3-D plot Drag while holding shift key 

and left mouse button
Move plot laterally Drag while holding alt key and 

left mouse button
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The 3D plot is useful to spot patterns that are quite different from the
others, as they tend to stand out on their own and are not easily
grouped. Also, cases where the colours (from the dendrogram) and
the positions (from the MMDS) of the samples appear to contradict
each other are the samples that should be looked at manually in more
detail.

To end this session select Close Window from the File menu. 

Automatic Quantitative Pattern Matching using Known Phases

A more sophisticated pattern match might include a database of
known phases for comparison purposes. These are patterns that have
been previously identified and can be used to decide whether the
sample is a previously known substance, a mixture of known
materials, or something completely different.

5.1.7  Selecting the Input, Output and Known Phase Folders

To begin, the user should start with the empty PolySNAP M window
containing the menu bar, as in the previous example.

Alter size of spheres Drag up or down while holding 
control key and left mouse but-
ton

Zoom on centre Click in area, hold shift key and 
use mouse scroll wheel

Zoom on area Hold left mouse button and 
draw box over area

Select a sample Click on sphere
Select multiple cells Hold control key and select 

additional cell
Alter rendering quality Press F2 and adjust scale

(lower values are better for 
slower graphics cards)

Centre view Right click mouse and select 
Centre Selection

Reset view Right click mouse and select 
Reset View
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From the File menu, select Automatic Analysis and the Run on...
option. The following dialog box will appear.

Set the input, output and known phase folders as before, except this
time we will additionally select a folder containing some known
phases prepared earlier.

1. To define the input folder containing the sample data files, click 
the Folder button in the top section of the dialog box. A folder-
selection dialog box will appear.

2. Select the drive containing the tutorial data from the pop-up
menu at the top. In this case, select D:.

3. Navigate to the folder C:\Program Files\PolySNAP M\tuto-
rial\simple_txt\. Ensure that the last folder of the path
(simple_txt) is selected by double clicking it (the folder icon
should appear 'open').

4. Click OK. The selected path should be displayed in the upper
portion of the dialog box. Check it is correct; if it is not, repeat
the previous step.

5. The known phase folder containing the known sample data files
must be defined. Turn on the checkbox labelled Use Folder or
Database containing Known/Reference data files. Click the
Folder button in the that section of the dialog box.

6. Select the drive containing the tutorial data, in this case D:.
7. Navigate to the folder C:\Program Files\PolySNAP M\tuto-

rial\simple_txt\known\. Ensure that the last folder of the path (i.e.
known) is selected by double clicking it (the folder icon should
appear 'open'), and click OK. This folder contains an example
pattern of each of Form A, B, C etc.
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8. The output folder where the result files are to be placed must be
defined. Click the third Folder button in the bottom section of the
dialog box. A folder selection dialog box will appear as before.

9. Select the local hard disk on your machine, which in this case is
C:. (Alternatively any other drive you wish to place the output
data may be selected.)

10. Navigate to the folder you wish to place the output files. e.g.
C:\output\. If required use the New Folder button to create new
folders. Ensure that the last folder of the path is selected by dou-
ble clicking it (the folder icon should appear 'open').

11. Click OK, and check that the desired path is displayed correctly.
12. Finally, in the Run PolySNAP M on... dialog box click OK.

The pattern files in the specified input folder are now loaded into
PolySNAP M, which proceeds to the matching and analysis phase
automatically after loading the 21 datafiles. 

When complete the results window will appear, with an initial view
of the Cell Display as before.

5.1.8  Viewing the Results

The input files are now displayed in the Cell Display as in the first
tutorial example. However, it now looks a little different with cells
MIXT_1 and MIXT_2 being shown as pie charts.

Unlike the previous run, the colours here are not taken from the
dendrogram plot, but from comparing each sample in turn to the
provided known phases. Samples such as MIXT_1 and 2 that do not
give high matching correlation coefficients to any of the known
reference patterns are tested to see if they are mixtures, and if so,
quantitative analysis is performed. The results from this are
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displayed in pie-chart form, the colours of each slice corresponding
to the pure phases listed in the key on the left hand side.

Another change to the view is the sample key - it now shows the
known phases FORM A to FORM E. By clicking on the colours of
the key all the samples matching the designated phase are selected.
For example, clicking on the red box labelled FORMA, cells A1 to
A4, as well as MIXT_2 are selected, as they are all of the samples
thought to either be, or contain, Form A. The key titles are taken
from the reference phase filenames.

Select the tab labelled Dendrogram. This view is exactly the same as
in the first example, including cell 20 being contained within the
yellow group.

The reason for this difference between views is that the cluster
analysis does not take the known phases into account. Only the
results shown in the Cell Display are directly affected by them.
Because of the way they work, the dendrograms and other methods
merely show the similarity between samples without taking account
of the known phase information.

With the quality of data available for this sample the predicted
mixture composition is not very good, and the quantitative results
should therefore be taken as a very approximate measure, certainly
not accurate to any more than around 10% at best. This approximate
value could however be useful as a starting point for a more rigorous
analysis later.

5.2  Identification of Amorphous Samples

The first two tutorial examples of this tutorial have covered simple
PolySNAP M procedures. This part will cover some of the more
advanced options available that include pattern matching while
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allowing for a 2θ-shift, and automatic identification of non-
crystalline samples.

To begin, the user should start as before with only the empty
PolySNAP M window containing only the menu bar as before.

From the File menu, select Automatic Analysis and the Run on...
option. The following dialog box will appear.

1. To define the input database containing the sample data, click the 
Folder button.

2. Select the drive containing the tutorial data, in this case D:.
3. Navigate to the folderC:\Program Files\PolySNAP M\tuto-

rial\advanced\
4. Ensure that no known phases are used by making sure the rele-

vant checkbox is turned off.
5. Define the output folder where the result files are to be placed. 

Click the third Folder button in the bottom section of the dialog 
box. A dialog box will appear.

6. Navigate to the folder you wish to place the output files. e.g. 
C:\output\. If required, use the New Folder button to create new 
folders, ensuring that the last folder of the path is selected by 
double-clicking on it (indicated by the folder icon being in an 
open position). Click OK.

7. Leave the Advanced Options settings at their default values.
8. In the Run PolySNAP M on... dialog box click OK.

The pattern files in the specified database are now loaded into
PolySNAP M, where it checks for amorphous samples, matches the
patterns with one another, and performs a cluster analysis. This may
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take a little time to complete, but once finished the results window
will appear with an initial view of the Cell Display.

5.2.1  Analysis of the Results

The 35 samples contained within the database are now presented in
the Cell Display.

The program is using the last few digits of the filename of each
sample to label them. Selecting pattern number 25505, the pattern
information display shows that it has been labelled as a non-
crystalline sample, which seems reasonable given its profile.

The other two patterns, 25506 and 26702 are similarly labelled for
the same reason. Identification of such amorphous samples is done
on the basis of checking to see if any signal (corresponding to peaks)
would be left after subtraction of the entire amorphous hump. The
method tends to err on the side of caution. 
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Looking at the Dendrogram tab:.

It is seen that three non-crystalline labelled patterns are placed on the
far right of the diagram with a zero similarity to the rest. This is
deliberate, in order to remove them from the main clusters. There
also appears to be one main grouping of the data - within which some
patterns seem much more closely grouped than others. Compare this
to the 3D (MMDS) plot:

Again, the three non-crystalline samples are quite separate from the
rest of the patterns. Both the dendrogram and 3D plots suggest a
loose grouping of the rest of the patterns, suggesting there may be
some differences between them.

Using the control key, click two patterns which are on opposite sides
of the main (yellow) group from each other, for example patterns
9401 and 69403. Examining their profiles, it appears that in addition
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to some preferred orientation issues, there seems to be a noticable 2θ-
shift between the otherwise relatively similar profiles:

This completes the initial analysis of the data, but the 2θ-shift in
some of the samples could be examined in more detail. From the File
menu select Close Window.

5.2.2  Reprocessing the Data allowing for an x-shift

When collecting powder diffraction data from a diffractometer the
sample or instrument alignment can result in linear or non-linear
shifts along the x-axis of the resulting pattern. This can especially be
a problem with the Bruker GADDS systems if the sample height
varies from sample to sample. This can give rise to systematic errors
in the pattern matching unless it is accounted for. However, to allow
for this is a time consuming process and should therefore not be used
unless such a shift is suspected - it is switched off by default. 

A general expression for the shift is:

(5.1) 

where the a0 coefficient corresponds to a linear (zero-point) shift
described earlier, and the a1 coefficient a non-linear component
[Zevin & Kimmel, 1995]. The requirement then is to find values of a0
and a1 that results in a maximum matching correlation result between
two patterns. The default maximal allowed values for a0 and a1 are
0.4.

The same data as in the previous run will now be examined again.
Unlike the last time, the program will vary the x-offset parameters to
attempt to maximise the match result. 

Define the input database, known phases and output folder as before:

1. From the File menu, select Automatic Analysis and the Run on... 
option. Define the same input folder as used before in the previ-
ous run of PolySNAP M. D:\tutorial\advanced\

2. Select None for the known phases directory.
3. Ensure that an appropriate output folder is selected. e.g. C:\out-

put\.
4. In the Advanced Options area, turn on the Allow x-shift calcula-

tion (sin theta) checkbox.

∆ 2θ( ) a0 a1 θsin+=
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5. In the Run PolySNAP M on... dialog box click OK.

The same data as before is now run allowing x-shifts on the patterns.
The time required to process this will take much longer than a normal
run of PolySNAP M. For this data the calculation will take
approximately ten times longer than before - so prepare to be patient!

When finished, the initial output should look similar to the previous
run:

Now look at the 3D MMDS plot. Previously, it looked like this:

Now, with the option to calculate the best-offset value for each
pattern turned on, it looks like this:

The three non-crystalline patterns are still quite separate, but the rest
of the patterns have condensed together as a result of allowing for the
2θ-shift, showing that a large part of the differences between the
pattern profiles was due to variation in sample heights during data
collection. The program still separates them out within this grouping
due to the preferred orientation problems.
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Similarly with the dendrogram display, the similarity values between
the patterns are much improved. The remaining differences appear to
arise from preferred orientation effects, which are quite noticable in
some cases. For example, overlay the profiles of samples 401 and
69403: 

5.3  Manual Matching: Working with Databases

The rest of the examples in this tutorial demonstrate the manual
analysis section of PolySNAP M. This mode can be accessed from
the Manual Analysis section of the File menu. 

The first thing to do is to create a new database of patterns with
which to work.

We first need to create a new database, which will initially be empty
We will then load some powder patterns into it, and work with them.

Choose New Database from the Manual Analysis section of the File
menu. A standard Windows file dialog box appears, and you are
invited to choose a name and location for the new database.
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Enter tutorial1 as the database name, select a location (C:/ for
example), and click Save. The dialog box disappears, and a new
window opens inside the PolySNAP M workspace. 

This is our new empty database; its filename is displayed in the
window title bar. Like any other window, it can be moved around the
screen by clicking and dragging on the title bar, and can be re-sized
by dragging at the edges of the window.

The filename and your selected location appear in the Database
Information section of this new window. 

The number of patterns in this database is also displayed - as
expected, it is currently zero.

Several buttons are arranged along the bottom of this window. Most
of these are unavailable as there are no data files in the database. The
only one that is available for use is the Import button.

We now need to bring some pattern data files into the database. 

Click the Import button. We need to navigate to where the data is
stored - C:\Program Files\PolySNAP M\. The folder manual should
be found within the 'tutorial' folder.

Once in the correct location, a list of different files in the folder that
the program recognises is listed. 
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We want to open all of the files in this particular folder, so hit
control-A on the keyboard to select them all, and then click Open. A
new window appears with the pattern processing options. 

These will be discussed in more detail later, so leave them with their
default values for the moment and click OK. A progress bar appears
at the top of the database window to allow progress to be monitored.
As there are only a few patterns in the folder, this process should only
take a couple of seconds.

Once importing has finished, the patterns will be listed in the main
part of the database window:
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If the window is too small to see all of the patterns, the scroll bar on
the right hand side can be used to view the rest, or you can drag the
window border to enlarge the window.

Each entry in the list represents one pattern file that has been
imported. 

Initially, the patterns are listed in the order they were imported. The
list can be sorted by either Pattern Name/ID, or Filename, by
clicking on the headers at the top of the list.

If some of the chemical names here look very similar to filenames
this is because the ASCII files we have imported do not contain any
chemical name information, so the filename is used instead. The
actual chemical name, if known, can be added manually later.

You can select a particular pattern in the list by clicking once on it.
When you do so, the other buttons along the bottom of the window
become activated.

The Import button has already been used. The Export button lets you
make a copy of a particular database entry to a separate file, in either
ASCII text or PolySNAP M pattern format.

Remove deletes the selected pattern or patterns from the database. 

Experiment with these options by exporting a pattern to a separate
ASCII text file under the name exporttest.txt. Make sure to note
where you saved it! Then try importing the file you have just saved.
Finally, select the exporttest.txt pattern in the list and delete it from
the database using the Remove option. 

Removing patterns from the database does not in any way affect the
original data files which are left intact and unchanged throughout all
operations performed using PolySNAP M - the program works on a
copy of the data only.

The Match and Edit options will be dealt with in following sections,
so leave them be for the moment.

Now quit the program by choosing Exit from the File menu. All
windows will close. Note that any changes made to a database are
automatically saved, so there is no need to manually save any
changes before closing.

Relaunch the program again in the same manner as before. We want
to return to the database we have just been working with. You could
select Open Database from the Manual Analysis section of the File
menu, navigate to where the database was saved, select it and click
Open, but there is a much easier way.
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The program keeps a record of the last four databases used in the
Recent Databases submenu of the Manual Analysis section of the
File menu. Open this now; one of the entries should be the

tutorial1.par database we were using earlier. Select it from the menu,
and it should start to open automatically.

Next, we want to examine some of the patterns we have just imported
in more detail.
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5.4  Editing Patterns

Select the pattern nh4no3.txt from the list in the database by clicking
once on it. Click the Edit button, and the Pattern Editor window
appears.

Several useful pieces of information about the pattern you have
selected are displayed in this window, and a plot of the pattern itself
is shown at the bottom.

The chemical name or pattern ID can be changed here by editing the
current name ("NH4NO3 -70 to 149°C Courtesy of Fraunhofer ICT")
in the white text box.

Details such as the pattern filename, its start and end angles, and the
number of data points are also displayed.
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There are three check boxes labelled Processing Options just above
the region where the pattern is displayed. To begin with, click once in
each of the checkboxes, so that they are all turned off:

Then click Apply. The graphing region should now look like this:

As you can see, the data has been scaled along the y-axis to run from
0.0 to 1.0. This operation is performed for all data being imported
into PolySNAP M in order to allow for suitable scaling between
different data sets.

The raw data has also been interpolated from its original resolution,
to the PolySNAP M standard 0.02 degrees. Again, this is for
consistency between patterns.

You can zoom into the pattern display, by clicking and dragging a
rectangle on the region you wish to see more closely:
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The view will then change to just the selected region:

To return to original view, right-click anywhere on the pattern
display, and select Reset View from the resulting pop-up menu.
Multiple zooms are possible by repeating the process.

Now click the Subtract Background checkbox, and then click Apply.
The pattern display should change:

The green line represents the raw pattern data. The blue line shows
the same pattern after the background level has been subtracted. To
see what the program considered to be background before
subtractions, select Show Background Curve from the Pattern menu.
A new window will open showing the subtracted background curve
where the blue line now represents what is subtracted as background.
Once you are finished looking, click Close to close this window and
return to the standard view.

Now click the Smoothing checkbox, so both it and the Background
Subtraction boxes are checked, and click Apply again.

The graph pane will be updated, and any noise in the pattern will be
smoothed out (shown here zoomed in).
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Finally, check the Find Peaks option, and click Apply.

The pattern display will update, and several small blue circles should
appear on the top of the larger peaks:

These mark the location of what the program considers peaks. There
is a minimum peak height below which any peaks are ignored. This
is set as a default to 0.05, which is why the smallest peaks are
unmarked.

A list of the peaks the program has found is shown in the upper right
corner of the pattern editor:

This lists the peaks found in order of increasing Bragg angle, and
displays the corresponding intensity for each.

If the program has missed a peak you believe should be included, it is
easy to add manually. Note that peak locations are added to the blue,
processed pattern line, not the green, raw data line on the graph
profile.
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For example, if we wish to add the small peak that is located at
around 54°, just right-click once at the point on the graph where you
judge the peak maximum to be:

Then select Add Peak from the resulting pop-up menu. A round blue
peak marker should appear at the top of the peak, and an entry for it
should be added to the peak list:

If this does not appear, try clicking as close as possible to the top of
the peak. It may help to zoom in to the area of interest.

It is also possible to remove peaks you believe to be incorrect. For
example, say we wish to delete the marker from the peak around 18°:

Right click as close to the peak marker as possible, and select
Remove Peak from the pop-up menu that should appear. The peak
marker, and its corresponding entry in the peak list, should vanish.
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If the Remove Peak option is unavailable from the pop-up menu, you
have not clicked close enough to the marker. Zoom in to make this
easier, and try again. 

Finally, it is possible to adjust the minimum peak height threshold to
include less of the smaller peaks. Look at the slider just below the
peak list - it should be set to 0.05.

Drag the handle on the slider until it is set to about 0.25. 

Several additional peaks that were marked before should now show
up without peak markers, as they are now below the new minimum
threshold of intensity.

Finally, return the slider to 0.05. The peaks that previously became
unmarked should show up again.

Now click on the Advanced tab in the top-left of the window. 

The top section revealed allows us to mask selected regions of the
pattern to be ignored during matching or analysis processes. This
may be useful where a particular peak is negatively affecting results.
Say we wish to mask the peaks in the region of the pattern between
15° and 25°. Enter the start and end angles of the region to be masked
in the relevant text boxes. 
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Examine the blue processed pattern in this region to determine its
average background level – in this case, a value of zero should
suffice, so enter 0.0 in the level text box, and click Apply.

The change in the pattern should be quite noticeable – while the
green line of the raw data is untouched, the blue processed data line
no longer has any peaks or features between the ranges we have
entered:

Now repeat the process and mask the peak at approximately 90°
using the same method.

Once finished, return the pattern to its initial state by clicking Reset
All.

The rest of the Advanced tab options will be discussed in the
Analysing Mixtures section later in this tutorial.

Choose Close Window from the File menu to dismiss the editor
window. The program will check if you wish to retain any of the
changes made in the editor. At present you do not want to keep any
changes, so click No. You are returned to the main database window.

Feel free to look at some of the other patterns in the database in the
editor window, and investigate the various processing options.
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5.5  Matching Patterns

Assume that you have just obtained a new, unknown, powder pattern.

You want to find out what pattern in your existing database it is most
similar to - and hence possibly identify what substance it may
represent.

First, close any currently open database or editor windows.

Now, go to the Manual Analysis section of the File menu, and select
Open...

Open the pattern database you created earlier, c:\tutorial1.par.

A new database window will open, and the pattern data will be
loaded into it.

The first step would normally be to import the unknown pattern into
this existing database in order to examine it. In our case however, it is
already loaded in the database.
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Locate the pattern Unknown.txt in the scrolling list of patterns in the
database, click once to select it, and then click on the Match button.
The main program match window will appear.

Our unknown pattern is displayed in the graph pane in the bottom
half of the window. Note that the pattern name and the database we
are using are listed at the top right. On the top left of the window are
the matching and analysis controls contained within two tabs –
Pattern Matching and Quantitative Analysis. The default tab is
Pattern Matching, which is what we wish to do first.

Click on the Match button. A progress bar appears as the program
runs through various tests in order to compare our selected pattern to
every other pattern in the database. Once matching is complete, the

centre section of the window fills with the numerical results, sorted
by the column in bold type, Rank.
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To sort the results by a different column, click once on that column’s
header. To change the sort order, e.g. to sort a column ascending
instead of descending, or vice versa, click the header again. For the
moment, click on the Rank header to re-sort by this column, and
ensure the largest value (normally 1.0) is at the top of the list.

Look at the pattern associated with this value. This is what the
program considers the ‘best match’ to our unknown. If it looks
familiar, that is because it is – it is the Unknown.txt pattern itself.
Because it is in the database, it is compared to itself. If this does not
result in perfect match scores, there is a problem somewhere, so this
is a useful check. 

More interesting is the next entry down in the list. The next best
match has a rank value of above 0.9, quite close to the perfect score
of 1.0. The individual test scores reading along the row reflect this:
all close to 1.0. The rank value is calculated by default by summing
the Spearman and Parametric test scores and dividing by 2.0.

To see these scores reflected visually, we can overlay the best-match
pattern with the unknown pattern. Click once in the left-most column
of the pattern you wish to overlay (the one with ‘2’ in it in this case).

The ‘2’ is replaced by a coloured dot, and a pattern in this colour
appears in the graph pane. It is obvious the two patterns are very
similar. Click on the coloured dot in the left-hand column once again
to remove the extra graph.

This suggests our unknown sample is aspirin.

Experiment with overlaying different graphs on the unknown; this
helps to get a feel for how the pattern scores correlate to similarity
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between patterns. Several patterns can all be overlaid at once on the
graph; to clear them all in one go select Clear Overlaid Graphs from
the Graph menu.

5.6  Analysing Mixtures Manually

Using PolySNAP M, open the database file quant.par in the tutorial
data folder. (Normally found on the PolySNAP M CD-ROM in the
'tutorial files', e.g. tutorial -> manual_data).

It contains four patterns – one mixture, and the three pure component
phases.

We will use the program to quantify the amounts of each phase in the
mixture. Select the mixture from the list of patterns, and click Match
to bring up the match window.

Go to the Quantitative Analysis tab, and click calculate. After a few
seconds when a progress bar is displayed, the program should display
its answers.



Analysing Mixtures Manually
These are in a similar form as before, except that there are two
additional columns – Scale % and Std Dev – the amount of each
phase in the mixture, and the error on the calculation.

There are various ways available to see if the programs suggested
percentages are sensible. First, check the Scale Graphs box on the
upper left. 

Then click on the left-most column of the results table for one of the
phases. 

As before, this overlays the selected pattern over the mixture, but is
now scaled to the percentage intensity suggested by the programs
analysis. The pattern should hopefully look sensible. 
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Another option is to click the Residual button, which brings up a
window with two graph panes. 

The upper one superimposes a simulated mixture pattern, made up of
combining the pure phases in the amounts suggested by the program,
on top of the original mixture. The bottom panel is then the
difference between the two. This difference plot helps show up either
missing phases or extra intensity which is not part of the mixture. If
required, it can be output to a file to be imported as a new pattern at a
later date. In this case, the small amount of residual intensity suggests
the calculated answer is quite good.

Click Close to dismiss the window.

So far, we have quantified the mixture in terms of how much of each
of the pure phase patterns are required to make it up. A more useful
number in the real world would be in terms of the weight of each
phase used in the mixture.
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In order to calculate this, we need to add some additional information
to each of the pure phase patterns. To do this, first select the database
quant.par from the list of open windows in the Window menu. 

This brings it to the front. Now select the first pure phase pattern:
Phase 1. Click Edit to bring up the pattern editor window, and click
on the Advanced tab.

We need to enter information into the lower region of this window, in
particular the chemical formula of the phase, its unit cell dimensions,
and the number of formula units per unit cell. 

Using the information in the table, enter the relevant details for this
phase, and click Update. The fields showing molecular weight and
absorption coefficients and so on for this phase should update. If not,
be sure to enter the formula in the form

       <Atomic Symbol><No. of atoms> <AtomicSymbol><No. of atoms> etc.

(The allowed formats for formula entry are discussed in more detail
in section 3.3.11, Additional Pattern Information in the main program
manual).

Repeat for the other two phases.

Phase Formula a b c α β γ Z
Phase 1 Al2 O3 4.7592 4.7592 12.992 90 90 120 6
Phase 2 Ca F2 5.4649 5.4649 5.4649 90 90 90 4
Phase 3 Zn O 3.2501 3.2501 5.2071 90 90 120 2
159



160
Once all sets of information have been entered and updated, go to the
program Options dialog box in the Edit menu. 

Go to the Advanced tab, and make sure that the Calculate Weight
Fractions when all information is present option is checked. Then
close the Options dialog by clicking OK.

Click on the mixture pattern database entry to select it, before
clicking the Match button to bring it up in the main match window.

Return to Match window, and in the Quantitative Analysis tab, click
Calculate again.

This time, the results table should be slightly different – the results
should be headed Weight % rather than Scale %. If not, go back and
check that all of the three pure phases has had the extra information
added successfully.

If successful, the weight fractions should be close to:

Phase 1 – 3%

Phase 2 – 78%



Conclusion
Phase 3 – 19%

which are the correct answers.

5.7  Conclusion

This completes the basic tutorial. There are many other features and
options in the program that should allow much more complex
problems to be examined. Each of these are described in the full
program manual, which should be consulted for more information.
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CHAPTER 6 PolySNAP M Release Notes
PolySNAP M Version 2.0.1
• Fixed an issue in countries using the comma as a decimal point

where shifted patterns were not being displayed correctly in the
Numerical Results pane.

• A new program splash screen and window background are dis-
played.

• The program version number is now displayed in program title bar.

• The program, documentation and website now use the new Bruker
logo.

• A new option has been added to force quantitative analysis to be
attempted on all input samples regardless of how similar they are
to the reference phases. This can be selected via the 'Perform anal-
ysis on all samples regardless of similarity’ checkbox in the
Options: Automatic: Advanced / Quantitative options  dialog box.

PolySNAP M Version 2.0.0
• The installer now adds a copy of the tutorial files to a folder

named tutorial in the SNAP Program Files folder.

• The copy-protection system has been updated, and the License
menu item removed as it is no longer used.

• PolySNAP M incorporates a limited subset of the PolySNAP style
graphical analysis and cluster analysis tools, for datasets of up to
96 patterns.

• The program manual and other documentation has been compre-
hensively reorganised.
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